
Glossary

Use the TAB key to select the word whose definition you want, then press and hold ENTER. With the mouse, point to the word, 
press and hold down the left mouse button.

Accelerator key
Access password
Application
Administrative Installation
Callback
Carbon Copy Terminal
Carbon Copy Terminal Script Language
CD
Chat
Chat windows
COM port
Connection
Connection Security
CTS
Dial modifiers
DCD
Dimmed
Direct connection
DTR
Event Log
File Transfer
Local
Login name
Login password
Maximize
Minimize
MNP
Modem
Phone Book
Port
Reboot
Remote
Remote Clipboard
Remote Control
RS232 cable
RTS
Serial Port
Shortcut key
Start upon Connection
TAPI (Telephony API)
Terminal Emulator
UART
Uninstall
Utility
Wait for Call





View Menu Commands

Toolbar
Determine how you want Toolbar buttons displayed, or hide the Toolbar. You can display the toolbar with 
Small, Large, or No toolbar buttons.

Status Bar
Toggle the Status Bar on and off.

Show Tray Icon
Show or hide the Carbon Copy “CC” icon in the tray in the lower right corner of your screen.

Phone Book
Display the Phone Book tab. Set up Phone Book entries.

User Profiles
Display the User Profiles tab. Set up User Profiles.

Status
View the Status tab.

AutoPilot
View the AutoPilot tab.

Network
Refresh the information on the current tab.

View
Displays icons on the Carbon Copy tabs as large icons, small icons, in list format or detailed list format.

Arrange Icons
Arrange icons by name or type.

Refresh
Refresh the information displayed on the Carbon Copy tab.
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Status Tab
The Status tab displays information about Carbon Copy activity, such as devices you have set to wait for 
call. You can toggle the Status tab on or off.

To toggle the Status tab:
Select or deselect Display Status, located on the Options menu. A checkmark next to this command indicates that it is on.



Network Tab
The Network tab displays available Carbon Copy network users you can connect to.

To toggle the Network tab:
1. Select Browse Network, located on the Connections menu, or click the Browse button in the main 

Carbon Copy window.
2. To stop browsing the network, select Stop Browsing Network, located on the Connections menu, or 

click the Browsing button in the main Carbon Copy window.



Toolbar
The buttons on the Toolbar are graphic representations of utilities or functions of Carbon Copy that are 
available from the Carbon Copy window. Many Carbon Copy features are available through both Toolbar 
buttons and menu commands.
For example, to start Remote Control, you can either click the Remote Control Toolbar button or choose 
the Remote Control command from the Utilities menu.
If you have a mouse, the easiest way to choose a Toolbar button is to click on it. Or, use the keyboard to 
select the Toolbar button by pressing tab and then pressing spacebar or enter to start the selected utility.
You can determine the size of the buttons on the Toolbar. You can display the buttons on the Toolbar as 
large buttons, small buttons or display no buttons. 

To customize the Toolbar buttons:
1. Select Toolbar, located on the View menu. A submenu with three options appears.
2. Select Large Buttons to display the Toolbar using large buttons. The Large Buttons option is selected 

by default. Select Small Buttons to display the Toolbar using small buttons. Select None if you do not 
want to display the Toolbar.

3. To change the way the Toolbar is displayed, simply select a different option from the Toolbar 
submenu.



Status Bar
The Status Bar displays a line of information at the bottom of the Carbon Copy window that provides 
information about the currently selected menu item or toolbar button. The Status Bar is on by default.

To toggle the Status Bar:
1. Select or Deselect Status Bar, located on the View menu. A checkmark next to this item indicates that 

it is on.



Displaying Icons
To customize the icons:
1. On the View menu, select View. A submenu appears. 
2. Select how you want icons displayed on Carbon Copy tabs. You can choose to have the icons 

displayed as Large Icons, Small Icons, List format or Detailed list format. The Large Icons option is 
selected by default. 

3. To change the way icons are displayed, simply select a different option from the View submenu.



Arrange Icons
To arrange icons:
1. On the View menu, select Arrange Icons. A submenu appears.
2. From the submenu, select By Name to arrange the icons alphabetically by name, or By Type to 

arrange the icons by connection type.



Refresh
The Refresh option updates the status of the current tab. For example, if you have the Network tab 
displayed, and select Refresh, the list of users on the Network tab will be updated to display Carbon Copy
users on the network to which you can connect.

To refresh the list of available Hosts:
1. Select Refresh, located on the View menu. The information on the current tab will be updated.



Edit Menu Commands

Cut
Cut an icon from a Carbon Copy tab, and place a copy on the Windows Clipboard.

Copy
Copy an icon from a Carbon Copy tab, and place a copy on the Windows Clipboard.

Paste 
Paste an icon from the Windows Clipboard onto a Carbon Copy tab, or your desktop.
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Edit Menu - Cut
To cut icons:
1. Select the icon you want to cut.
2. On the View menu, select Cut; or press the right mouse button and select Cut; or press ctrl+x. 
3. A copy of the icon is placed on the Windows clipboard. You can now paste the icon in the active tab, 

or directly on your desktop.
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Edit Menu - Copy
To copy icons:
1. Select the icon you want to copy.
2. On the View menu, select Cut; or press the right mouse button and select Copy; or press ctrl+c.
3. A copy of the icon is placed on the Windows clipboard. You can now paste the icon in the active tab, 

or directly on your desktop.
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Edit Menu - Paste
To paste icons:
1. Make sure you cut or copied an icon before pasting it.
2. Select Paste, located on the Edit menu; or press the right mouse button and select Paste; or press 

ctrl+v.
3. On your Windows desktop, press the right mouse button and select Paste. The icon appears on your 

desktop.
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Phone Book Introduction
Phone Book entries contain information about Carbon Copy users you call frequently. Entries can include 
names, phone numbers, login names and login passwords. When you place a call, Carbon Copy will dial 
the Phone Book number automatically, and send a login name and password if required. 
The Phone Book tab contains a list of Carbon Copy and Dial-Up Networking connections that you have 
created. You create Phone Book entries using the Create New Connection Wizard on the Phone Book 
tab. Each Phone Book entry contains information about the PC you will make a connection to, such as a 
name and phone number. You can start a connection by double clicking the Phone Book entry icon. 
You may set an access password on the Security Options dialog box to protect your Phone Book from 
unauthorized users. This is useful to prevent connected users from editing your Phone Book during 
Remote Control. All information in the Phone Book is encrypted when it is stored to disk, so that anyone 
browsing through your files cannot open the Phone Book file and view its contents.
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Displaying the Phone Book Tab
Display your Phone Book tab when you want to add or edit entries. To dial an entry from your Phone 
Book, just double click it, or highlight a Phone Book entry and click the Call button.

Notes...
· Each Phone Book entry must have a name. It may also include a telephone number, login name and 

login password. Login names and passwords are only needed if the PC you are calling requires them.
· You can require anyone attempting to open your Phone Book entries to provide a valid access 

password. An access password is NOT required by default.
· You can open your Phone Book during a connection, or while using other Carbon Copy utilities.
· Note that a connected user can edit your Phone Book during Remote Control, unless you set an 

access password for it.
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Modem and Direct Connection Entries
To create a new Carbon Copy modem or direct connection entry:
1. Select the Phone Book tab.
2. Double click on the Create New Connection icon, or select Create New Connection from the File 

menu.
The first Make New Connection Wizard dialog appears.

3. On the Make New Connection Wizard dialog box, select Connect using Carbon Copy.
4. Type a name for the PC you will be connecting to. Use a name that helps you identify the entry, such 

as the location of the PC or its principal user. 
If you are making a modem connection, select a modem type. If you did not set up your modem 
during installation, click Install Modem. If you want to make changes to the way the selected modem 
is set up, click Configure.
If you are making a direct connection, select Serial Cable or Parallel Cable, depending on the type of 
cable you are using to make the connection.
Click Next to continue.

5. Select the Telephone Number text box and type a phone number. Make any necessary changes in 
the Area code or Country code fields. Click Next to continue. If you are making a direct connection 
between two PCs, this dialog box will not appear.

6. If the PC you will call requires a login name, select the Login Name text box and type a login name.
If the PC you will call requires a login password, select the Login Password text box and type a login 
password. It is displayed as asterisks. You must retype the password exactly as you typed it the first 
time in the Confirm Password text field. Click Next to continue.
If you leave the login name and/or login password blank and the other PC requires it, you are 
prompted to enter it when you place the call. 

7. Select the Carbon Copy utilities that you want to start automatically after you make a connection. 
Remote Control is selected by default.

8. The final dialog box appears, telling you that you have successfully created a new connection. If you 
want to make any changes to this connection now, click the Back button. The dialog boxes you just 
completed will reappear. You can make changes to this connection later by highlighting the 
connection icon and changing its properties.

9. To make a connection now, select the Establish Carbon Copy Session now checkbox. When you click
the Finish button, the Connect dialog box will appear. Click Connect to start the Carbon Copy 
connection.

Your changes are saved when you choose Finish and exit the New Connection Wizard.

Notes...
· The name you give an entry is how it is listed in the Phone Book tab. Use a name you will recognize, 

like the location or user of the PC.
· Login names and passwords are only needed for PCs that require logins. If you do not include login 

information for a PC that requires it, you will be asked for it when you call.
· Phone Book names, login names, and login passwords may include any displayable character 

(including spaces), and are NOT case sensitive.
· Phone numbers can include digits, the * (asterisk) and # (pound sign), and dial modifiers. You can 

add characters such as hyphens and spaces for legibility. Carbon Copy will accept up to 38 
characters, but some modems have shorter limits. You can have entries without phone numbers, to 
send login names and passwords to direct connected or mobile PC’s that require them.
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IPX and TCP/IP Connection Entries
To create a new IPX or TCP/IP connection entry:
1. Select the Phone Book tab.
2. Double click on the Create New Connection icon, or select Create New Connection from the File 

menu.
The first Make New Connection Wizard dialog box appears.

3. On the Make New Connection Wizard dialog box, select Connect using Carbon Copy. 
4. Type a name for the PC you will be connecting to. Use a name that helps you identify the entry, such 

as the location of the PC or its principal user. 
In the Connect Using section of the dialog box, select IPX Network or TCP/IP Network.
Click Next to continue.

5. Type the name of the Workstation to which you want to connect.    Alternately, you can type a 
workstation’s IP address.
Click Next to continue.

6. If the PC you are connecting to requires a login name, select the Login Name text box and type a 
login name.
If the PC you are connecting to requires a login password, select the Login Password text box and 
type a login password. It is displayed as asterisks. You must retype the password exactly as you 
typed it the first time in the Confirm Password text field. If you leave the login name and/or login 
password blank and the other PC requires it, you are prompted to enter it when you place the call. 
Click Next to continue.

7. Select the Carbon Copy utilities that you want to start automatically after you make a connection. 
Remote Control is selected by default.

8. The final dialog box appears, telling you that you have successfully created a new connection. If you 
want to make any changes to this connection now, click the Back button. The dialog boxes you just 
completed will reappear. You can make changes to this connection later by highlighting the 
connection icon and changing its properties.
If you want to make a connection now, select the Establish Carbon Copy Session now checkbox. 
When you click the Finish button, the Connect dialog box will appear. Click Connect to start the 
Carbon Copy connection.
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Dial-up Networking Connection Entries
To create a Dial-Up Networking connection:
1. Select the Phone Book tab.
2. Double click on the Create New Connection icon, or select Create New Connection from the File 

menu.
The first Make New Connection Wizard dialog box appears.

3. On the Make New Connection Wizard dialog box, select Connect using Dial-Up Networking. 
4. Type the name of the computer you will be connecting to. Use a name that helps you identify the 

entry, such as the location of the PC or its principal user. 
Select a modem type. If you did not set up your modem during installation, click Install Modem. If you 
want to make changes to the way the selected modem is set up, click Configure. 
Click Next to continue.

5. Select the Telephone Number text box and type a phone number. A phone number is not required if 
you will be directly connected to the PC by a null modem cable. Make any necessary changes in the 
Area code or Country code fields. Click Next to continue. If you are making a direct connection 
between two PCs, this dialog box will not appear.

6. The final dialog box will appear, telling you that you have successfully created a Dial-Up Networking 
connection. If you want to make any changes to this connection now, click the Back button. The 
dialog boxes you just completed will reappear. You can make changes to this connection later by 
highlighting the connection icon and changing its properties. 
If you want to make a connection now, select the Establish Carbon Copy Session now checkbox. 
When you click the Finish button, the Connect dialog box will appear. Click Connect to start the 
Carbon Copy connection.

Notes…
· Create a Dial-Up Networking connection when you want to access information on another PC, even if 

your PC is not on a network. The PC you are connecting to must be set up as a network server for 
you to be able to access the shared resources. For more information, refer to Microsoft Windows on-
line help, or consult your network administrator.
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Deleting Phone Book Entries
To delete an entry from your Phone Book:
1. Display the Phone Book tab.
2. Select the Phone Book icon you want to delete.
3. Select Delete, located on the File menu, or press the right mouse button and select Delete.
4. A dialog box will appear, asking if you are sure you want to delete the selected icon:

Select Yes to delete the icon, or No to keep the icon on the Phone Book tab.
If you select Yes, the icon is removed from your desktop.
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Copying and Pasting Phone Book Entries
To cut and copy an entry from your Phone Book:
1. Display the Phone Book tab. 
2. Select the Phone Book entry you want to cut or copy.
3. On the View menu, select Cut to cut the icon or Copy to copy the icon. 

A copy of the icon is placed on the Windows clipboard. You can now paste the icon in the active tab, 
or directly on the desktop.

To paste a Phone Book entry:
1. Make sure you cut or copied a Phone Book entry before pasting it. 
2. Select the Phone Book tab.
3. Select Paste, located on the Edit menu, or, on the Phone Book tab, press the right mouse button and 

select Paste.

Notes…
· Each Phone Book entry you create is represented by an icon. You can copy, cut, paste, rename and 

delete those icons. When you delete an icon, it is removed permanently from your desktop, you will 
not be able to paste it in another location. When you cut an icon, you can paste it in another location. 
You can also create a shortcut, and place the shortcut icon directly on your desktop. 
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General Tab
On this tab, you can change the Area code, Telephone number, Country code, Modem type and Modem 
configuration for the selected Phone Book entry. If the Phone Book entry represents a network 
connection, different fields will appear, as explained below. Make any necessary changes in these fields. 
Press tab to move between text boxes.
Area Code - Enter the area code for the location you are calling.
Telephone Number - Enter the phone number for the location you are calling.
Use country code and area code - Select this box if you want the country code and area code sent as 
part of the phone number when you make a connection.
Connect using - Select the device type you will use to make a connection. 
Configure - Configure the selected device type.
Workstation Name (Network Connection Only) - Type the name or network address of the computer 
you want to connect to.
Internet Locator Server (TCP/IP only) - After you select Use the Internet, you must add or select an 
Internet Locator Server (ILS). An example of an ILS address is: uls2.microsoft.com/scripts/ulserver.dll. 
You must enter the server location (uls2.microsoft.com is the server location in the above example). If 
you do not enter the other parts of the address, the defaults shown in the above example will be used. 
If you have previously added an ILS address in the Communications Browse or Wait for Call tab, they will 
appear in the drop down list of Internet Locator Servers.
When you add an ILS, the ILS will also be added to the list of ILS entries on the Browse or Wait for Call 
tab.
Use the Internet (TCP/IP only) - Select to browse for Carbon Copy systems located on Internet Locator 
Servers. ILS is available from Microsoft as part of their Microsoft Conference Server product. Contact 
Microsoft for more information.
Dial-up Networking Connection (Network Connection Only) - Select a dial-up networking connection.
Use Dial-up Networking (Network Connection Only) - Select Use Dial-up Networking when you want 
to access shared information on another computer, even if your computer is not on a network. The 
computer you are connected to must be set up correctly as a network server for you to gain access to it.



Login Tab
On the Login tab, you can change login information used when you connect to another PC. The login 
information you enter will be automatically authenticated when the connection is established.
Login Name - Enter the name used to login to the remote PC.
Login Password - Enter the password used to login to the remote PC. The password will appear as 
asterisks.
Confirm Password - Retype the Login Password in this field exactly as you typed it in the Login 
Password field. If the login and confirm passwords do not match, you will be prompted to type them again.



Startup Tab
On the Startup tab, select the Carbon Copy utilities you want to start automatically after a connection is 
established.
Select Display Connect Dialog box if you want a dialog box to appear during your connection, informing 
you of the status of your connection. This option is selected by default.



New Connection Wizard
Use the New Connection Wizard to create a new Carbon Copy connection. After you are done creating a 
new connection, you can place a call to another PC. 
You can create both Carbon Copy connections and Dial-up networking connections. Create a Carbon 
Copy connection when you will be connecting using a modem, a local area network, or via direct connect.
Create a Dial-up networking connection when you will be establishing a remote network node.
To continue, click Next.



New Connection Wizard - Name and Connection Type
Enter a name to represent the PC you are connecting to. Enter a name that will help you identify the PC, 
such as its location, or the name of the person using it. The name may include any displayable character 
(including spaces). Names are NOT case sensitive.
Select the type of device you will use to make the connection. You can select a modem, direct or network 
connection. If your modem is not listed, click the Install Modem button. If you want to change the current 
settings of your device, select the device and click Configure.
To continue, click Next.

Notes…
· If you are running Carbon Copy on a Windows NT 3.51 PC, the Install Modem button will be disabled.

When you select the Configure button, the Windows Control Panel will appear. Select the Network 
icon to make any changes to the network connection.



New Connection Wizard - Phone Number
Enter the telephone number of the PC you will be calling. If the PC is located in a different area code or 
country, make sure you enter area code and country code information. If you do not enter a phone 
number, you will be prompted to enter one when you start the connection.
To continue, click Next.



New Connection Wizard - Workstation Name
In the Workstation Name field, type the name or network address of the computer you want to connect to.
If you are creating a TCP/IP connection, you can select the Use the Internet checkbox. 
Select Use the Internet to browse for Carbon Copy systems located on Internet Locator Servers. ILS is 
available from Microsoft as part of their Microsoft Conference Server product. Contact Microsoft for more 
information.
After you select Use the Internet, you must either select an ILS or add one in the Internet Locator Server 
section. An example of an ILS address is: uls2.microsoft.com/scripts/ulserver.dll. You must enter the 
server location (uls2.microsoft.com is the server location in the above example). If you do not enter the 
other parts of the address, the defaults shown in the above example will be used. 
If you have previously added an ILS address in the Communications Browse or Wait for Call tab, they will 
appear in the drop down list of Internet Locator Servers.
When you add an ILS, the ILS will also be added to the list of ILS entries on the Browse or Wait for Call 
tab.
To continue, click Next.



New Connection Wizard - Login Information
In these fields, enter information used when you make a connection to another PC. The information you 
enter here is sent automatically.
Login Name - Enter the name used to login to the remote PC.
Login Password - Enter the password used to login to the remote PC. The password will appear as 
asterisks.
Confirm Password - Retype the Login Password in this field exactly as you typed it in the Login 
Password field. If the login and confirm passwords do not match, you will be prompted to type them again.

Click Next to continue.



New Connection Wizard - Start Upon Connection
On this tab, select the Carbon Copy utilities you want to start automatically when you make a connection. 
Remote Control is selected by default.

Click Next to continue.



New Connection Wizard - Finish
This is the last screen for the New Connection Wizard. If you want to make any changes to the 
information you entered on previous screens, click Back. The screens you just entered information on will 
reappear. When you are done creating this Phone Book entry, click Finish. The entry will be saved, and 
will appear in your Phone Book tab.

When you are ready to make a connection, double click the Phone Book entry. If you want to make a connection now, select the 
Establish Carbon Copy Session Now checkbox, and then click Finish.



Creating a Shortcut
To create a shortcut:
1. On the Phone Book tab, highlight the Phone Book icon to which you want to create a shortcut.
2. Drag the selected Phone Book icon onto your desktop, or press the right mouse button and select 

Create Shortcut. Select Yes on the dialog box that appears to place the shortcut on your desktop.
Once you have created a shortcut to a Phone Book icon, you can double click on that icon to start 
Carbon Copy and connect to another PC.



Global Security
The options on the Global tab of the Security Options dialog box allow you to determine a caller’s access 
to your Phone Book, User Profiles, Security Options dialog box and PC.
Global Security is generally used to protect your Carbon Copy settings from a user calling in and using 
remote control to access your PC.

To set global security options:
1. Enter a password in the Security Password field. The password can be up to 16 characters long. 

The password you enter will appear as asterisks.
2. Select the utilities you want to protect with the security password. You can select the Phone Book, 

User Profiles, AutoPilot, or Security Options dialog box.
3. In the Startup section of the dialog box, you can choose to load Carbon Copy before Windows 

prompts you to login. Select this option if you want Carbon Copy to start automatically when you start 
Windows. If you want to start Carbon Copy and have it set to Wait for Calls, select the Wait for Calls 
on Startup option on the Communications dialog box.

 4. Click Apply. A dialog box will appear, asking you to confirm the security password. Retype the security
password exactly as you did the first time, and click OK.
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Session Security
Use the options on the Session tab of the Security Options dialog box to select the amount of time 
allowed for a Carbon Copy session, and the amount of time the connection can remain inactive before the
session is ended.

To set session security options:
1. In the Host Keyboard and Display section, select Disable Keyboard and Mouse to disable the 

Host keyboard and mouse. Select Disable Display to disable the Host display. This can help prevent 
unauthorized access to the Host PC during Remote Control. This does not affect the image of the 
Host screen that appears on the Guest PC. 

2. In the Session section, select the Enable Inactivity Timeout checkbox if you want to set the amount
of time the connected PC can remain inactive before ending the connection. If the user remains 
inactive for the selected amount of time, the connection will automatically end. The default Inactivity 
Timeout is 15 minutes. If both the PC making the connection and the connected PC select this option,
but choose different times, the shorter amount of time selected will be used as the inactivity Timeout.

3. Select Enable Session Time Limit if you want to set the maximum amount of time for each session, 
in minutes. The Carbon Copy session will automatically end at the time limit you have selected. The 
default Session Time Limit is 60 minutes.

4. Click OK to save your changes, or click Cancel to cancel your changes and exit the dialog box.
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Connections Security
The options on the Connections tab of the Security Options dialog box allow you to determine what 
happens when a caller connects to your PC. You can choose if you want to be notified when a caller 
attempts to connect to your PC, and if you want to approve the connection. You can require that all users 
connected to your PC be called back by your PC. Also, you can choose to reboot upon disconnect and 
load Carbon Copy automatically when you start Windows.

To set connections security options:
1. Click the box next to the connection security options you want. You can select as many of the options 

as you want.
Notify on Connect: Informs you when another user attempts to connect to your PC.
Approve Connections: Requires you to approve all connections made to your PC.
Require Callbacks: All users will be called back when they connect to your PC. You must supply a 
callback number for the user on the Callback tab of the User Profiles Properties dialog box. If you do 
not supply a callback number, the user will be disconnected.
Reboot on Disconnect: Determines if your PC reboots when a connection ends. If multiple PCs are 
connected, they all must disconnect before the reboot takes effect. 
Logoff on Disconnect: Determines if the current user will be logged off when a connection ends.
Allow Outbound Calls: Selected by default. Deselect if you do not want outbound calls to be made 
from your PC.
Maximum Connections: Select the maximum number of connections allowed during a Carbon Copy 
session. The maximum is 256.

2. Click OK to save your changes, or click Cancel to cancel your changes and exit the dialog box.
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Login Security
The options on the Logins tab of the Security Options dialog box allow you to require logins from callers 
connecting to your PC. You can also select how many incorrect login attempts the caller will get before 
they are disconnected.    If you select Require Logins, each caller must provide a login name to connect 
with your PC. You set up login names for callers on the User Profiles tab in the main Carbon Copy 
window. When connection security is enabled, you can also choose if each caller must provide a login 
password. By default, login names and passwords are NOT required

To set login security options:
1. Select or deselect the Require Logins check box. When you select this checkbox, all callers must 

provide a valid login name to gain access to your PC. When you leave this box unchecked, callers will
have unprotected access to your PC.

2 If you are using Windows NT and if Carbon Copy is running as a service - if it was loaded before the 
Windows login prompt - then you have the option of using Native NT Security.
Native NT Security uses Windows NT user accounts to determine which callers have access to your 
PC.
Native NT security also gives you the option of logging off your NT workstation when a user connects 
via Carbon Copy.    This is an added level of security to prevent unauthorized access.

3. Select the number of Login Attempts you want the caller to have. By default, 3 login attempts are 
allowed. You can allow a minimum of 1 login attempt, and a maximum of 10.

4. Select the Login Timeout, in seconds. This is the amount of time the user has to attempt to login. By 
default, 30 seconds are allowed. You can allow a minimum of 1 second and a maximum of 60 
seconds.

5. Select the minimum length for the login password. The login password you assign to the remote user 
must be at least the number of characters specified here.

6. Click OK to save your changes, or click Cancel to cancel your changes and exit the dialog box.

Notes…
· If you do not requires logins, the Default User settings will be used.
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Encryption Security
The options on the Encryption tab allow you to enable data encryption, and assign a custom manual key. 
This type of encryption provides extra security when making Carbon Copy connections. In order for data 
encryption to work, the PC you are connecting to must also have data encryption enabled. If you assign a 
custom manual key, the PC you are connecting to must have the same manual key entered in the User 
Manual Key section of the Security Encryption dialog box.
To set encryption security options:
1. Select the Enable Data Encryption checkbox. Data Encryption is only supported if the PC you are 

connecting to is using Carbon Copy 4.1 or later, and has data encryption enabled.
2. Optionally, you can select the User Manual Key checkbox. Enter a two hexadecimal digit in each of 

the eight fields. You can enter the characters 0-9 and A-F. For example, you can enter: A0 B1 C2 D3 
E4 F5 67 89.    If you do not use the User Manual Key checkbox, then Carbon Copy chooses an 
encryption key for you.
The PC you are connecting to must have the same manual key entered in the User Manual Key 
section if the Security Encryption dialog box.

3. Click OK to save your changes, or click Cancel to cancel your changes and exit the dialog box.

Notes….
When you are making a connection to a PC using a version of Carbon Copy earlier than 4.1, you must 
disable this feature. This feature is not supported by version of Carbon Copy earlier than 4.1.
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Native NT Security

Carbon Copy 32 can use native Windows NT security to simplify management of User Profiles. When you
use native NT security in Carbon Copy 32, User Profiles are based on Windows NT user accounts. You 
can then apply restrictions based on the caller’s group affiliation.
Important: .You must set up Carbon Copy 32 as a service before using native NT security. Use one of 
the following procedures.

To set up Carbon Copy as a service:
1. Select the Start Service icon in the Carbon Copy Program group. Carbon Copy 32 is now running as 

a service. If you use this method, you must select the Start Service icon each time you start Carbon 
Copy 32.
- or -
Open the Security dialog box, located on the Options menu. On the Global tab, select the Load 
Carbon Copy before Windows Login Prompt checkbox. Carbon Copy 32 will now run as a service 
automatically every time you start Windows NT.

To select native NT security:
1. Open the Security dialog box, located on the Options menu.
2. Display the Logins tab.
3. Select Require Logins. 
4. Select Use Native NT Security.

Important: This option is only available on Windows NT.
5. Select Logoff NT on Connect if you want to logoff a previously logged on user from the workstation 

once a new user is successfully connected. This prevents unwanted access to the workstation’s 
resources and security features when a user making a connection does not have security privileges, 
but the user who is currently logged in does. For example, a user without privileges could make a 
connection to a logged in user, such as an administrator, and then use Remote Control to change the 
machine settings.

6. Click OK to save your changes, or click Cancel to cancel your changes and exit the dialog box.
Carbon Copy 32 will now display the users and groups in Windows NT on the User Profiles tab. 
Carbon Copy will automatically update the information on the User Profiles tab whenever you add or 
delete a new NT user or group.



Managing User and Group Profiles
To Create New Group Profiles:
1. Display the User Profiles tab.
2. Double click the User Manager icon.    The Windows NT User Manager appears. Refer to the User 

Manager on-line help for more information.
3. Once you have created a new group, you can right click on the new group icon, and select the 

properties option to change the group’s properties.
4. Select the Carbon Copy 32 utilities you want the group to have access to. Any changes you make in 

the User Manager will appear in the User Profiles tab
5. Click on the OK button.

Important: You cannot make changes to individual User Profiles, you can only make changes to 
group profiles. The individual users inherit properties from the groups they belong to. Changes are 
allowed for call back settings.

To Modify User Profiles:
1. Display the User Profiles tab.
2. Double click the User Manager icon. The Windows NT User Manager appears. Refer to the User 

Manager on-line help for more information on how to find out which group a user belongs to.
3. Right click on the group icon that the user belongs to, and select the properties option to change the 

group’s properties.
4. Select the Carbon Copy utilities you want users within the group to have access to. For example: 

Remote Control or File Transfer.
5. Click the OK button.

The profiles of all users in this group will inherit the changes. 
To Modify User Profiles for Call Backs:
1. Display the User Profiles tab.
2. Right click on the user icon, and select the properties option to change the user’s properties.
3. Select the desired Call Back options. 
4. Click the OK button.
To Disallow Connections:
Groups and users who are members of those groups can be denied access to the PC. This can be used 
to manage which groups and users are allowed access to a PC.
1. Right click on the group icon that you want to disallow connections to, and select the properties option

to change the group’s properties. Uncheck the Allow Connections checkbox. 
2. Click on the OK button.

Connections by users within this group will no longer be allowed. 
To Allow Users to Login on Different Domains:

Carbon Copy users can be chosen from one or more domains. 
When a user logs onto a particular domain, the exact domain/user name format must be strictly 
adhered to, as shown in the user profile tab. 



Data Encryption
The Encryption tab in the Security Options dialog box allows you to enable data encryption and, 
optionally, to assign a user defined key. Data encryption provides an extra measure of security when 
making Carbon Copy 32 connections. The user defined key is a sequence of hexadecimal numbers that 
acts as the key for opening the connection between your PC and the remote PC.
For Carbon Copy 32 to establish a connection with data encryption between two PCs, one or both of the 
PCs must have data encryption enabled. If you assign a user defined key, both PCs must use the same 
key .
Important: When you make a connection to a PC using a version of Carbon Copy earlier than 4.1, you 
must disable the data encryption feature. This feature is not supported by versions of Carbon Copy earlier
than 4.1. To see which version of Carbon Copy you are using, select About Carbon Copy 32, located on 
the Help menu.

To set encryption security options:
1. Click on the Carbon Copy 32 Security icon, and select the Encryption tab in the Security Options 

dialog box. 
If you cannot access the Security Options dialog box, check the User Profile options on your PC to 
make sure that your user profile includes Security.

2. On the Encryption tab, select the Require Data Encryption checkbox. Carbon Copy will choose an 
encryption key for you.    
If you want to create a user defined key, select the User Defined key checkbox . 
For a user defined key, enter a two digit hexadecimal number in each of the eight fields. You can 
enter the characters 0-9 and A-F. For example, you can enter: A0 B1 C2 D3 E4 F5 67 89.
If you want to enable data encryption, but do not want a user defined key, select only the Require 
Data Encryption checkbox. This enables a default key.    This is a unique key generated each time 
there is a connection.
When a user defined key is used, however, both the remote PC and your PC must use the same user
defined key. This provides you with an extra level of protection because a person trying to connect to 
your PC must know the user defined key in order to make a connection.

3. Click OK to save your changes, or click Cancel to cancel your changes and exit the Security Options 
dialog box.
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Event Log
Use the Event Log to keep track of messages generated by Carbon Copy events. Any messages 
generated are sent to a file which you can view using Windows Notepad.
1. Select Event Log from the File menu.

By default, all available events are selected to be displayed in the Event Log. 
2. Deselect any event type or class you do not want displayed in the Event Log.
3. Use the Wrap Log Events checkbox to choose the format in which events are logged. If you want text 

to wrap automatically, select this checkbox.
4. Enter the location where you want the Event Log to be saved. By default, the Event Log is saved to 

the directory where Carbon Copy is installed.
5. Press the Start Log button to start the Event Log. Any Carbon Copy events from now on will be saved

to the Event Log.
6. To view the Event Log, press the View Log button.
7. Press Stop Log to stop logging events.

Notes...
· Event Classes are Information, Warning and Error. Information events generate messages that 

inform you system tasks have been completed. Warning events generate messages that inform you 
system tasks have not been completed. Error events generate messages that inform you a fatal error
has occurred. 

· Event Types are Security and Login, Communications, File Transfer, Remote Control and Other. 
Security and Login events inform you when someone is accessing or disconnecting from your PC. 
Communications events inform you about numbers called or Timeout and disconnect information. 
File Transfer events tell you if file transfer operations were successful. Remote Control events 
inform you of actions that occur during Remote Control. Other event types provide information about 
the Event Log.



Setting up Wait for Call
Carbon Copy must be set up to Wait for Calls before answering a call from another Carbon Copy user. 
The first time you select Wait for Call, or, if you have used Carbon Copy before, but did not select any 
devices to wait for call on, the Wait for Call dialog box appears. For more information on the Wait for Call 
dialog box, see Selecting Devices to Wait for Incoming Calls. 

To set your PC to Wait for Calls:
1. Choose Wait for Call, located on the Connections menu, or click the Wait for Call push-button in the 

main Carbon Copy window.
The Carbon Copy - Waiting for Call message appears at the top of the Carbon Copy window. The 
Wait for Call button on the Carbon Copy toolbar changes to Waiting. 

Notes...
· While you are Waiting for Calls, you can use other Windows applications, but not other Carbon Copy 

utilities.
· Check the Status tab for a list of devices that you have set to Wait for Call. The Status tab lists the 

device name, and if it has successfully been set to Wait for Call. 
· A PC can be unattended if it is set to wait for call. When waiting for calls, the Carbon Copy - Waiting 

for Call message appears at top of the Carbon Copy window, and the Wait for Call button changes to 
Waiting.
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Selecting Devices to Wait for Incoming Calls
The first time you select Wait for Call, or, if you have used Carbon Copy before, but did not select any 
devices to wait for call on, the Wait for Call dialog box appears. On this dialog box, select devices you 
want to use to wait for incoming calls.
1. Select the devices that you want to wait for call on by clicking the box next to the device name. You 

can select multiple devices. For example, you may want to select the type of modem you have 
connected to your PC, and your network type. Incoming calls will be able to come from either the 
modem, or over the network.

2. When you are done selecting devices, click OK to save your changes and exit the dialog box. Click 
Cancel to exit the dialog box without saving your changes.
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Wait For Call on Startup
The Wait for Call on Startup option determines if Carbon Copy will automatically be set to answer calls 
the next time you start Carbon Copy. A PC can be left unattended if it is set to Wait for Call on Startup.

To answer calls automatically when you start Carbon Copy:
1. Open the Communications dialog box, located on the Options menu.
2. Select the Wait for Call tab.
3. Select the Wait for Call on Startup checkbox in the Options section of the dialog box.
4. If you want Carbon Copy to run minimized when you wait for calls, select the Minimize on Wait for 

Call checkbox.

Notes...
· Carbon Copy must be Waiting for Calls to answer a remote PC trying to establish a connection.
· You can also choose Wait for Call with the Wait for Call push-button or command, to answer calls 

immediately.
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Making a Connection
To make a connection:
1. Display the Phone Book tab. Select the connection icon you want to use to make the connection.
2. Select the Call button in the main Carbon Copy window, or select Place a Call, located on the 

Connections menu. The Connect dialog box appears.
3. Press Connect to start the call. If you want to cancel the call, press the Cancel button. 

If the other PC does not requires callers to login, the connection is established. If the other PC 
requires callers to login and the Phone Book entry you are using contains a valid login name and 
password, they are sent automatically. Otherwise, enter the login name and password and choose 
OK. The login password appears as asterisks. By default, you are allowed three login attempts before
you are disconnected.

Notes...
· The PC you are calling must be set to Wait for Calls.
· Any Carbon Copy utilities you selected to start upon connection will start after the connection is 

made. Remote Control is selected to start upon connection by default.
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Making an IPX or TCP/IP Network Connection
This procedure describes how to make a network connection using a Phone Book entry.

To make an IPX or TCP/IP connection:
1. Display the Phone Book tab. Select the connection icon you want to use to make the connection.
2. Select the Call button in the main Carbon Copy window, or select Place a Call, located on the 

Connections menu.
3. The Network Connect dialog box appears. Press Connect to start the call. If you want to cancel the 

call, press the Cancel button. 
If the other PC does not requires callers to login, the connection is established. If the other PC 
requires callers to login and the Phone Book entry you are using contains a valid login name and 
password, they are sent automatically. Otherwise, enter the login name and password and choose 
OK. The login password appears as asterisks. By default, you are allowed three login attempts before
you are disconnected.
Any Carbon Copy utilities you selected to start upon connection will start after the connection is 
made. Remote Control is selected to start upon connection by default.
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Making a Network Connection by Browsing
You can make a network connection by browsing for the PC you want to connect to. The PC you are 
browsing for must be set to Wait for Call.

To make an IPX or TCP/IP network connection browsing the network:
1. Select Browse Network, located on the Connection menu, or click the Browse button in the main 

Carbon Copy window. 
The Network tab appears, displaying a list of all the workstations currently set to Wait for Calls:

2. Select the Workstation to which you want to connect. 
3. Double click the icon, or select the Call button in the main Carbon Copy window, or select Place a 

Call, located on the Connections menu.
If the other PC does not requires callers to login, the connection is established. If the other PC 
requires callers to login and the Phone Book entry you are using contains a valid login name and 
password, they are sent automatically. Otherwise, enter the login name and password and choose 
OK. The login password appears as asterisks. By default, you are allowed three login attempts before
you are disconnected.
Any Carbon Copy utilities you selected to start upon connection will start after the connection is 
made. Remote Control is selected to start upon connection by default.

4. To stop browsing the network, select Stop Browsing Network, located on the Connections menu, or 
click the Browsing button in the main Carbon Copy window.
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Making a Direct Connection
A direct connection is made when two PCs are directly connected via a null modem cable, or the parallel 
port cable included with Carbon Copy. A null modem cable is a serial cable that has been modified so that
it can directly connect two PCs. When you make a direct connection between PCs, you eliminate the 
need for a modem. 

To make a direct connection:
1. Display the Phone Book tab. Select the connection icon you want to use to make the connection.
2. Select the Call button in the main Carbon Copy window, or select Place a Call, located on the 

Connections menu. The Connect dialog box appears. When making a direct connection, you do not 
have to enter a phone number in the Telephone number field. 

3. Press Connect to start the connection. If you want to cancel the connection, press the Cancel button. 
If the other PC does not requires callers to login, the connection is established. If the other PC 
requires callers to login and the Phone Book entry you are using contains a valid login name and 
password, they are sent automatically. Otherwise, enter the login name and password and choose 
OK. The login password appears as asterisks. By default, you are allowed three login attempts before
you are disconnected.

Notes...
· The PC you are calling must be set to Wait for Calls.
· Any Carbon Copy utilities you selected to start upon connection will start after the connection is 

made. Remote Control is selected to start upon connection by default.
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Ending Wait for Call
When you are Waiting for Calls, Carbon Copy will answer a call from another PC. You must exit Wait for 
Call to have Carbon Copy stop answering incoming calls.

To end Wait for Call:
1. Choose Cancel Wait for Call, located on the Connections menu, or click the Waiting button on the 

Carbon Copy toolbar.
The Waiting button on the Carbon Copy toolbar changes to Wait for Call. 

Notes...
· When Carbon Copy ends Wait for Call, your modem is set NOT to auto-answer, and your COM port is

released for use by other applications.
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Hanging Up
When you no longer want to be connected, Hang Up. The Call push-button and command become Hang 
Up when you are connected.

To disconnect your PC from a connected PC:
1. Choose Hang Up.
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Setting up an Internet Locator Server (ILS) Connection
This procedure describes how to set up an Internet Locator Server (ILS) connection.

To set up a new ILS connection entry:
1. Select the Phone Book tab.
2. Double click on the Create New Connection icon, or select Create New Connection from the File 

menu.
The first Make New Connection Wizard dialog box appears.

3. On the Make New Connection Wizard dialog box, select Connect using Carbon Copy. 
4. Type a name for the PC you will be connecting to. Use a name that helps you identify the entry, such 

as the location of the PC or its principal user. 
In the Connect Using section of the dialog box, select TCP/IP Network.
Click Next to continue.

5. Type the name of the Workstation to which you want to connect.
Select the Use the Internet checkbox.
In the Internet Locator Server list box select an ILS. If you have added any ILS names on the Wait for 
Call or Browse tab of the Communications dialog box, they will appear here. If the ILS you want to 
connect to is not listed, you may enter it now. 
An example of an ILS address is: uls2.microsoft.com/scripts/ulserver.dll. You must enter the server 
location (uls2.microsoft.com is the server location in this example). If you do not enter the other parts 
of the address, the defaults shown in the above example will be used.
Click Next to continue.

6. If the PC you are connecting to requires a login name, select the Login Name text box and type a 
login name.
If the PC you are connecting to requires a login password, select the Login Password text box and 
type a login password. It is displayed as asterisks. You must retype the password exactly as you 
typed it the first time in the Confirm Password text field. If you leave the login name and/or login 
password blank and the other PC requires it, you are prompted to enter it when you place the call. 
Click Next to continue.

7. Select the Carbon Copy utilities that you want to start automatically after you make a connection. 
Remote Control is selected by default. You may also select File Transfer, Chat or Remote Clipboard.

8. The final dialog box appears, telling you that you have successfully created a new connection. If you 
want to make any changes to this connection now, click the Back button. The dialog boxes you just 
completed will reappear. You can make changes to this connection later by highlighting the 
connection icon and changing its properties.
If you want to make a connection now, select the Establish Carbon Copy Session now checkbox. 
When you click the Finish button, the Connect dialog box will appear. Click Connect to start the 
Carbon Copy connection.



Add Internet Locator Service
Enter the address of an Internet Locator Server (ILS).
An example of an ILS address is: ils2.microsoft.com/scripts/ulserver.dll. You must enter the server 
location (ils2.microsoft.com is the server location in the above example). If you do not enter the other 
parts of the address, the defaults shown in the above example will be used.
When you are done adding the ILS, click OK. The ILS you added will appear on both the Wait for Call and
Browse tab on the Communications dialog box.



Using Internet Locator Servers (ILS)
Internet Locator Servers (ILS) provide a way for Carbon Copy 32 users to find and connect with each 
other over the Internet without having to remember each other’s Internet Protocol (IP) address. There are 
many Internet Locator Servers throughout the world, and Carbon Copy users can register themselves 
with one or more of them.
Internet Locator Servers are also useful to large corporate IP networks (Intranets).    Corporations can set 
up their own Internet Locator Servers to enable Carbon Copy browsing and connections over their 
network.    The ILS software runs on an NT server or Windows 95 workstation and is currently available 
free from Microsoft.
Registering with an ILS means that you have put Carbon Copy 32 into Wait for Call mode on the ILS, or 
that you browse on the ILS. The phone book and browse features of Carbon Copy 32 allow you to 
connect to a registered PC that is in Wait for Call mode. If your PC is registered with an ILS, other Carbon
Copy 32 users can connect to your PC while it is in Wait for Call mode.
When a Carbon Copy 32 user’s PC goes into Wait for Call on one or more Internet Locator Servers, 
Carbon Copy sends a message to each ILS that the PC is in Wait for Call mode. When you use the 
Carbon Copy browse feature to browse these servers, it queries each server about PCs in Wait for Call. 
In response to the query, each server sends a message to the browsing Carbon Copy informing it of the 
names of the PCs currently in Wait for Call. The icons for these PCs appear in your Carbon Copy network
tab. You can double click on one of the icons to make a connection.
You can also use the Carbon Copy 32 create connection wizard to make a new connection icon using an 
Internet Locator Server, or you can create a Phone book connection icon by right clicking on the icon in 
the browse tab. You can double click on one of the icons to make a connection
Before you can make a connection to another Carbon Copy 32 user, you need to know the name of the 
server where the user’s PC is registered. To see a list of active Internet Locator Servers and their users, 
go to HTTP://WWW.NETMEET/ILSLIST.HTM using your Internet browsing software. Internet Locator 
Servers are available from Microsoft as part of their Microsoft Conference Server product. Contact 
Microsoft for more information.
Before other Carbon Copy 32 users can make a connection to your PC, you must register your PC with 
an Internet Locator Server. You must also select the correct options on the Wait for Call tab. The 
procedures in the following sections describe how to add ILS entries, set up an ILS connection, and set 
your PC to wait for an ILS connection.



Waiting for Calls Using ILS
To set your PC to Wait for Call using an ILS:
1. Select the Comms button. 
2. Select the Wait for Call tab if it is not already displayed.  
3. Select the network connection type.    You must select at least one TCP/IP device to enable the ILS 

and Internet options.
4. Select the Use the Internet checkbox. All the ILS in the list box will be informed that your PC is in Wait

for Call. At this point, you can add or remove ILS servers from the list box. Click the OK button.    
Other users can now browse for your PC.
Important: If no servers are selected, but Use the Internet is selected, then calls can still be received 
by this PC.



Browsing and Connecting Using ILS
To set your PC to browse for Users in Wait for Call using an ILS:
1. Select the Comms button.
2. Select the Browse tab.
3. Select the proper network connection type.
4. Select the Use the Internet checkbox.
5. Click the OK button. 
6. Click the browse button on the Carbon Copy 32 user interface. 

If there are any Carbon Copy 32 users in Wait for Call on the ILS, their names will appear in the 
network tab.

7. You can double click on one of the icons to make a connection.
Important: If you want to browse a Dial-up Networking connection, you must select the TCP/IP 
Network on PPP Adapter option.



Adding ILS Entries
Complete the following procedures to add an ILS entry on either the Browse or Wait for Call. 

To add an ILS on the Browse or Wait for Call tab:
1. Select the Comms button, 
2. Select the Browse tab or Wait for Call tab.
3. Select the Use the Internet checkbox to browse for Carbon Copy 32 users registered with one or 

more Internet Locator Servers. 
Two ILS server selections appear by default: ILS1.Microcom.com, and ILS4.Microsoft.com.
After you select Use the Internet, you can add another ILS by completing the following step.

4. To add an ILS, click the Add button. The Add Internet Locator Servers dialog box appears.
Enter the address of the Internet Locator Server you want to browse for users in Wait for Call. An 
example of an ILS address is: ILS4.microsoft.com. 

5. When you have finished adding the ILS, click OK.
To remove an ILS, highlight the ILS in the list of Internet Locator Servers and click the Remove 
button. The ILS will be removed from the list without asking you for confirmation. 
When you add or remove an ILS, the ILS will also be added to or removed from the list of ILS entries 
on the Wait for Call tab.
Important: To see a list of active ILS servers, use your Internet browser to view the following web 
site: HTTP://WWW.NETMEET/ILSLIST.HTM.



Setting up an ILS Phone Book Connection
This procedure describes how to make a Phone Book connection using ILS.

To Make a Phone Book Connection Using ILS:
1. Select the Phone Book tab.
2. Double click on the Create New Connection icon.

- or -
Select Create New Connection from the File menu.
The first Create New Connection Wizard dialog box appears.

3. In the Create New Connection Wizard dialog box, select Connect Using Carbon Copy. Click on the 
Next button.

4. Type a name for the PC you will be connecting to. Use a name that helps you identify the entry, such 
as the location of the PC, or its principal user.
In the Connect Using section of the dialog box, select TCP/IP Network. 
Click Next to continue.

5. Type the name of the Workstation to which you want to connect.
6. Select the Use the Internet checkbox.

In the Internet Locator Server list box select an ILS. If you have added any ILS entries on the Wait for 
Call or Browse tab of the Communications dialog box, they will appear here. If the ILS you want to 
connect to is not listed, you may enter it now.
An example of an ILS address is: ILS2.microsoft.com. You must enter the server location. 
ILS1.microsoft.com is the server location in this example. 
Click Next to continue.

7. If the PC you are connecting to requires a login name, select the Login Name text box and type a 
login name. 
If the PC you are connecting to requires a login password, select the Login Password text box and 
type a login password. It is displayed as asterisks. You must retype the password exactly as you 
typed it the first time in the Confirm Password text field. 
If you leave the login name or the login password blank and the other PC requires it, you will be 
prompted to enter it when you place the call. 
Click Next to continue.

8. Select the Carbon Copy 32 utilities that you want to start automatically after you make a connection. 
Remote Control is selected by default. You may also select File Transfer, Chat or Remote Clipboard.

9. The final dialog box appears, telling you that you have successfully created a new connection. 
If you want to make any changes to the connection now, click the Back button. The dialog boxes you 
just completed will reappear. You can make changes to this connection later by highlighting the 
connection icon and changing its properties. 

10. If you want to make a connection now, select the Establish Carbon Copy Session now checkbox. 
When you click the Finish button, the Connect dialog box will appear. Click Connect to start the 
Carbon Copy connection.



Connecting Through Firewalls
Firewalls provide a protective barrier between workstations on a local area network and the Internet. This 
barrier prevents other computer users from accessing local resources from the Internet. 
Carbon Copy 32 can be configured to establish Internet connections through firewalls. However, this 
requires some support from your local network administrator in order to open the firewall so that other 
Carbon Copy 32 users can access your PC.

Connecting through Firewalls Using ILS
Your network administrator will have to configure the firewall to allow network traffic to pass on TCP port 
80 and TCP port 1680 before you perform the steps below. This method takes advantage of Carbon Copy
32’s ability to browse the Internet for available Carbon Copy 32 users. 
1. Set the host PC to Wait for Call on an ILS server as described in the Waiting for Call Using ILS 

section. This step registers your availability to an ILS server.
2. The person who wants to connect to your PC can then browse using an ILS, as described in the 

Browsing Using ILS section.
Connecting through Firewalls Without Using ILS
Your network administrator will have to configure the firewall to allow network traffic to pass on TCP port 
1680 before you perform the steps below. This method does not use the browse function. 
1. On the host PC, click on the Comms button, and select the Wait for Call tab, check the Use Internet 

checkbox, then use the Remove button to delete all the ILS servers in the list box on the tab.
2. Set your PC to Wait for Call. Since you removed all the ILS servers in Step 1, Wait for Call is not 

registered with any ILS server. Users browsing these servers will not see your PC listed, however, 
you will be in Wait for Call.

3. The person who wants to connect to the host PC can create a phone book entry as described in the 
section Setting Up an ILS Phone Book Connection. This phone book entry specifies either your PCs 
workstation name or your TCP/IP address. The workstation name works only if it can be resolved to a 
TCP/IP address. For example, by a DNS server.
Make sure that you do NOT select the Use the Internet checkbox.
The person who wants to connect to the host PC will not be browsing the Internet to find the host PC, 
but will be able to connect to it directly.



What is Remote Control?
Remote Control allows you to operate another PC as if you were sitting in front of it. You might use 
Remote Control to troubleshoot a software problem at a remote site, access an application that is not 
available on your own PC or use your office PC from an offsite location.
Although either user can start Remote Control and take control of another PC, the user who starts 
Remote Control is referred to as the Guest, and the PC that the Guest connects to is called the Host PC. 
During Remote Control, the keyboard and mouse actions on both PCs are controlled by the Guest. The 
Guest sees the image that appears on the screen of the Host PC. The Remote Control window can be 
displayed full screen, or in a window on the Guest’s PC.
During Remote Control, all Carbon Copy utilities on the Host PC are available to both the Guest and Host.
Both users can read the Host PC’s on-line Help, and edit the Host PC’s Phone Book or User Profiles 
(unless they are password protected and the remote user has not provided the passwords).
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Controlling A Remote PC
You must be connected to another PC to start Remote Control. By default, Carbon Copy automatically 
starts Remote Control whenever a caller establishes a connection with another PC. If you do not want 
Remote Control to start automatically when you make a connection, open the Properties dialog box for 
the PC you are calling in the Phone Book tab. Select the Startup tab and deselect Remote Control.

To start Remote Control:
1. Connect to a PC that is running Carbon Copy and has already been set to Wait for Calls. If you have 

set Remote Control to start when a connection is made, it will start automatically. If not, continue with 
the next step.

2. Select Remote Control, located on the Utilities menu, or click the Remote Control button on the 
Carbon Copy toolbar.
Once Remote Control has started, the Guest screen shows whatever is on the Host screen. The 
Connection tab for the connected PC indicates that Remote Control is active.
You can now remotely control a Windows or DOS application on the connected PC as if the 
application were running on your own PC. If you require security at the remote site, you can choose 
the Disable Host Keyboard and Mouse or Disable Host Display commands in the Security Options 
dialog box.

Notes...
· Either user may start Remote Control, and either may place the call to connect. A connection must be 

established before Remote Control can be started.
· During Remote Control, all other Carbon Copy utilities are available. Note that when you edit the 

Phone Book or User Profiles during Remote Control, you may be changing them on the connected 
PC, not your own.

· The Host's keyboard and mouse can be active, sharing control of the Host PC with the Guest, or they 
can be disabled. This option is located on the Session tab of the Security dialog box.

· The Host PC's screen display can be left on or blanked. This option is located on the Session tab of 
the Security dialog box.

· See "Tips on Using Remote Control,” in your Carbon Copy User's Guide, for hints on optimizing 
Remote Control sessions.
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Remote Control Views
You can select how you want to view the connected user’s screen during Remote Control. You can 
change these settings anytime during Remote Control, and they will take effect immediately.
Full Screen - When selected, the Host screen will completely fill the Guest display. If the Host screen 
display is larger than the Guest screen display, the Guest’s view of the remote screen will automatically 
scroll as the Guest moves the mouse to the edge of the screen. You can use Hot Keys to exit Full Screen 
Remote Control, or select the exit button from the floating toolbar.
When the Host screen display is larger than the Guest screen display, the Guest can use his mouse or 
the ALT+RIGHTSHIFT+ARROW KEYS to pan the view of the Host screen.
Windowed    - Selected by default. When selected, the Host screen will be displayed in a window on the 
Guest desktop. The Guest can move or resize the window any time during Remote Control. 
Select Stretch to Window if you want the Host display to always fill the Remote Control window on the 
Guest desktop. Stretch to Window mode may result in a distorted view of the Host display and decreased 
performance.
To switch between Remote Control views, click a toolbar button, or select a different view from the 
Remote Control menu.

Using Hot Keys to Change Remote Control Views
You can use the following hot key combinations any time during Remote Control:
· Use ALT+RIGHTSHIFT to exit Remote Control.
· Use ALT+RIGHTSHIFT+ENTER to toggle between Full Screen and Windowed Remote Control.
· Use ALT+RIGHTSHIFT+F to switch to Full Screen Remote Control.
· Use ALT+RIGHTSHIFT+W to switch to Windowed Remote Control.
· Use ALT+RIGHTSHIFT+S to switch to Windowed Stretch Remote Control.

Notes...
· Select the startup view on the Screen tab, located in the Remote Control Options dialog box. The 

Startup View you select determines how the Host screen will appear on the Guest screen when you 
start Remote Control.

· You can select a different view anytime during Remote Control using the toolbar, menus or hot keys.
· To exit during full screen DOS Remote Control, use the selected Hot Keys.
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Remote Control of DOS Applications
You can remotely control DOS applications in Windows. Both text and graphics mode applications are 
supported.

To run DOS applications in a Window or full-screen display:
1. Open a DOS window.
2. Press ALT+ENTER to change the display of the DOS application from full screen to being displayed in 

a Window.



Remote Control Security
Set Remote Control security options on the Security Options dialog box.

To set Remote Control security options:

1. Open the Security Options dialog box, located on the Options menu.
2. Select the Session tab.
3. Select Disable Keyboard and Mouse to disable the Host keyboard during Remote Control. Select 

Disable Display to blank the Host display during Remote Control.
4. Select OK to save your changes, or Cancel to cancel the changes and exit the dialog box.

{button ,AL(`security',0,`',`')}    Related Topics



Exiting Remote Control
To exit Remote Control:

Use one of the following methods to exit Remote Control:
· Select the Exit icon from the toolbar.
· Use the selected Hot Key combination, for example ALT+RIGHTSHIFT.
· Click the Close button in the upper corner of the Remote Control window.
· Switch to the User tab that represents the currently connected user. Highlight the Remote Control 

icon on the User tab and press the right mouse button. Select Close.
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Remote Control Options - Screen
On the Screen tab, you select the Startup View to be used during Remote Control. The Startup View you 
select determines how the Host screen will appear on the Guest screen when you start Remote Control. 
You can select a different view anytime during Remote Control using the toolbar, menus or hot keys.
When you select Full Screen, the Host screen will completely fill the Guest display. If the Host screen 
display is larger than the Guest screen display, the Guest’s view of the remote screen will automatically 
scroll as the Guest moves the mouse to the edge of the screen. If you want the Remote Control Toolbar 
displayed during Full Screen Remote Control, select Toolbar. The Toolbar is selected by default.
Windowed is selected by default. When you select Windowed, the Host screen will be displayed in a 
window on the Guest desktop. The Guest can move or resize the window any time during Remote 
Control. Select Stretch to Window if you want the Host display to always fill the Remote Control window 
on the Guest desktop. Stretch to Window mode may result in a distorted view of the Host display and 
decreased performance. To exit Windowed Remote Control, use the Hot Keys, the toolbar button or click 
the upper-left corner of the Remote Control window. Select Toolbar and Menus if you want them to be 
displayed during Windowed Remote Control. Toolbar and Menus are selected by default.
Select Always on Top if you want to display the Remote Control window on top of any other applications 
open on your desktop.



Remote Control - Desktop and Cache
In the Desktop section of the dialog box, the Disable Host Wallpaper checkbox is selected by default. 
When this option is selected, any desktop wallpaper on the Host PC will be turned off during Remote 
Control. Turning off any complex wallpaper will avoid delays when the screen is being repainted. When 
you exit Remote Control, the wallpaper is turned back on.
The Disable Host Screen Saver checkbox is selected by default. When this option is selected, any 
screen saver on the Host PC will be turned off during Remote Control. Turning off the screen saver will 
avoid delays when the screen is being repainted. When you exit Remote Control, the screen saver is 
turned back on.
The Ignore Large Bitmaps checkbox is not selected by default. By default, all bitmaps are displayed 
during Remote Control. When you select this option, large bitmaps such as splash screens are not 
displayed during Remote Control. Turning this option on will speed up Remote Control. However, if you 
are working with an application that uses large bitmaps, make sure you leave this option deselected. 
Once you select Ignore Large Bitmaps, you can then select the smallest size to ignore. 64 Kpixels is 
selected by default.
The Disable Font Smoothing checkbox is selected by default. When this option is selected, some fonts 
may appear jagged. Leaving this option selected increases Remote Control performance, because fonts 
take less time to redraw on your screen.
The Track Blinking Cursors checkbox is not selected by default. When this box is selected, the guest’s 
remote control view will automatically scroll to center on any blinking cursors such as a word processor 
cursor.
The Show Host Mouse Motion checkbox is not selected by default. When this box is selected, any 
mouse movements that a host user makes will be visible on the guest’s remote control view.
In the Cache section of the dialog box, the Enable Disk Cache checkbox is selected by default. This 
option allows you to set the maximum size for the Remote Control disk cache file, which saves graphical 
objects on the Guest PC between Remote Control sessions. Caching graphical objects increases Remote
Control performance. The default size of the disk cache is 5 MBytes.
Press the Defaults button to reset all the options on this tab back to their original settings.



Remote Control - Hot Keys
On the Hot Keys tab, select the hot key combination you want to use to exit Remote Control. The default 
hot key combination is ALT + RIGHTSHIFT.
The hot keys you select to exit Remote Control are also used, in conjunction with another key, to toggle 
between Full Screen and Windowed views during Remote Control. For example, if you select 
ALT+LEFTSHIFT as the hot key used to exit Remote Control, ALT+LEFT SHIFT+F would become the hot 
key you use to toggle between Full Screen and Windowed views. Any changes you make to hot key 
settings take effect immediately.
You can use the following hot key combinations any time during Remote Control:
· Use ALT+RIGHTSHIFT to exit Remote Control. 
· Use ALT+RIGHTSHIFT+ENTER to toggle between Full Screen and Windowed Remote Control.
· Use ALT+RIGHTSHIFT+F to switch to Full Screen Remote Control
· Use ALT+RIGHTSHIFT+W to switch to Windowed Remote Control
· Use ALT+RIGHTSHIFT+S to switch to Windowed Stretch Remote Control. 



Remote Control - DOS
On this tab, select the DOS Screen Scanning rates. You can enter both Graphics and Text scan rates.
Select the Synchronized checkbox if you want to synchronize the Host and Guest screens during full-
screen DOS Remote Control. If you do not select synchronized mode, the Guest and Host screens will 
not be synchronized during Remote Control. Synchronized screens can take longer to redraw.
The default synchronized rate for graphics is to scan every 5 ticks, the default for text is to scan every 3 
ticks. The range is from 1 to 255 ticks. 
The number you enter in the Rate box indicates how often, in ticks, the screen will be scanned for text or 
graphics to redraw. You can choose a different scan rate for text and graphics. You may want to select a 
slower scan rate for graphics, because graphics take longer than text to redraw. To select a slower scan 
rate for graphics, increase the scan rate value.



Remote Printing
The Carbon Copy 32 Remote Printing feature allows you to print documents to a local printer from a 
remote PC. 
Important: For Remote Printing to work effectively, the printer driver on the source PC must be 
compatible with the destination printer. For example, if your destination printer is an HP LaserJet 4, then 
the source PC should have the HP LaserJet 4 printer driver installed.
This chapter describes Remote Printing in terms of a source PC and a destination PC.
The source PC is the computer that originates the printing of a document. The destination PC is the 
computer physically connected to the printer where the document is printed. For example, if you are 
calling in to your office PC, and you want to print a document on your printer at home, your office PC is 
the source PC and your home PC is the destination PC.
Remote Printing is often used in conjunction with Remote Control.    In the example above, you could    
use Remote Control on your home PC to work on a document in the word processor on your office PC, 
and then print the document on the printer connected to your home PC.



Configuring Remote Printing
Before you can start to use Remote Printing, you need to configure both the source PC and the 
destination PC. You must configure the destination PC to print to its local printer, and you must configure 
the source PC to print to the Carbon Copy Printer Port.

To Configure the Destination PC for Remote Printing:
1. Click on Options in the Carbon Copy 32 Main menu, and select Remote Printing from the drop-down 

list.
The Remote Printing dialog box appears. 

2. In the Remote Printing dialog box, select the destination printer you want to use from the drop-down 
list. The destination printer should be configured normally. If you do not select a printer, Carbon Copy 
uses the default printer.
Important: You must NOT configure the destination PC to print to a Carbon Copy Port.

To Configure the Source PC for Remote Printing:
1. From the Windows Start menu, go to the Settings option and open the Printers folder.
2. In the printers folder, click on the printer icon for the printer you want to use, then click the right mouse

button to show a drop-down list of options. 
3. Select Properties from the drop-down list. The Printer Properties dialog box appears.
4. For Windows 95, in the Printer Properties dialog box, click on the Details tab.    For Windows NT, 

select the Port tab.
5. Select Carbon Copy Printer from the list of available ports.
6. Click on the Spool Settings button to make sure that bi-directional printing is disabled.
7. Click on the OK button to apply all settings.



Creating a Carbon Copy Printer Icon
For convenience, you may want to create a Carbon Copy printer icon on your source PC. This allows you 
to easily identify the printer when you print remotely.

To Create a Carbon Copy Printer Icon
1. Click on Options in the Carbon Copy Main Menu, and select Remote Printing. Click on the "Add New 

Printer" button.
- or -
Double click on the Add Printer icon in the Printers folder.

2. Follow the instructions for creating a local printer.
3. Select the Printer. For example, HP LaserJet 4.    This should be the same type of printer as the 

printer at the destination PC.
4. Select the Carbon Copy Printer port. 
5. Name your new printer icon. Use a name such as "HP LaserJet via Carbon Copy".
6. When prompted to "Print test page", select No.    Then press the Finish button.
7. In the Printer Properties dialog box, click on the Details tab.
8. Click on the Spool Settings button to make sure that bi-directional printing is disabled.
9. Click on the OK button to apply all settings.



Starting Remote Printing
To Start Remote Printing
1. Make a Carbon Copy connection to another PC.
2. Click on the Print button in the Carbon Copy user interface.

- or -
Click Utilities in the Carbon Copy main menu and select the Remote Printing option.
- or -
Double click on the Remote Printing icon in the View Window.    The Remote Printing icon will change 
to "Active".

3. On the source PC, print your document to a Carbon Copy printer. You can use Remote Control to do 
this, if you are not at the source PC. The document prints at the printer at the destination PC. 



Remote Printing Select Printer
On the PC attached to the physical printer, select the printer type from the list box.
If your printer does not appear in the list box, select Add Printer to add it.
If no printer is selected, Carbon Copy uses your PC’s default printer.
Be sure that this printer type matches the printer specified on the PC that is originating the remote printing
job.
When using Remote Printing, the originating PC should print to a printer configured to use the Carbon 
Copy Printer Port.
The print destination PC should be configured to print to a normal printer - a printer that is not configured 
to use the Carbon Copy Printer Port.



Using Remote Printing with Remote Control
To Remotely Print a Document:
1. Make a Carbon Copy connection to another user’s PC, and launch Remote Control and Remote 

Printing.
2. While in Remote Control, start printing from the application on the source PC. Be sure to print to the 

Carbon Copy printer.    The document prints at the printer on the destination PC.



Starting File Transfer
File Transfer allows you to copy, synchronize and delete both individual files and complete directories and
to create or remove directories on your own PC or the connected PC. File Transfer is similar to Windows 
Explorer. It uses the same directory tree structure and many of the same keyboard and mouse 
techniques. If you are familiar with Windows Explorer, you should find File Transfer easy to use.

To start File Transfer:
You must be connected to another user to start File Transfer. Use one of the following methods to start 
File Transfer:

Select File Transfer, located on the Utilities menu.
or
Click the File Transfer button on the Carbon Copy toolbar.
or
Double-click the File Transfer icon located on the selected Connection tab.
or
Highlight the File Transfer icon on the Connection tab. Press the right mouse button and select Start.
or
Open the Properties dialog box for the icon representing the connected PC. Select the Startup tab. 
Select File Transfer. File Transfer will be started upon connection.

Notes...
· Either user can start File Transfer, and both users can have their File Transfer windows open at once, 

but only one user can copy files at a time. 
· When your File Transfer window is open, you can copy and delete files, and create and remove 

directories.
· You can minimize your entire File Transfer window and use other applications while the other user 

transfers files in the background. 
· If either user closes the File Transfer icon or window, File Transfer is ended on both sides.
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Getting Around the File Transfer Window
File Transfer is similar to Windows Explorer, using the same directory tree structure, and many of the 
same keyboard and mouse techniques. Because it operates over both connected PC’s, there are two 
sets of windows - one for each PC.
When you are specifying files or directories in File Transfer, you indicate the PC you mean by selecting 
the window that represents that PC.
Selection in File Transfer is similar to Windows Explorer. To select a single file, click on it with the mouse. 
To select multiple adjacent files, click on the first file, then hold down the SHIFT key while selecting the last
file in the group. The files in between will be selected also. Holding down the CONTROL key while 
selecting a file toggles it from selected to deselected, or vice versa. You can use this technique to select 
multiple files that are not next to each other in the directory window, or to deselect individual files from 
those already selected. 
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Copying Files and Directories
The Copy command on the File menu transfers files and directories between connected PCs. You can 
copy files and directories from your own PC to the connected PC, or from the connected PC to your own 
PC. 

To copy files or directories to or from the connected PC:
1. In either your File Transfer window, or the connected PC’s File Transfer window, select the drive and 

directory that contain the file(s) or directories to copy.
2. In the other File Transfer window, select the destination drive and directory to which you will copy the 

files or directories. All files must be copied to the same directory.
3. Click the file(s) or directories to copy. To select multiple files in sequence, click on the first file, then 

hold down shift and click on additional files. To select multiple files not in sequence, click on the first 
file, press and hold down the ctrl key and click on the next file you want to select.

4. Choose Copy from the File menu to display the Copy dialog box.
5. Choose Copy from the Copy dialog box to begin copying.

The status of the Copy is displayed as the file(s) is copied.

Notes...
· Files or directories are copied from the PC which has the focus to the PC which does not have the 

focus. 
· You can copy files from only one directory at a time, and they must all be copied into a single 

directory on the other PC.
· The Copy List box shows the number of files remaining to copy and their names. Before or during 

copying, you can select files from this list and choose Remove from Copy List if you decide not to 
copy them. 

· When a file in the destination path has the same name as one you are copying, you will be alerted, if 
File Replace is checked in the Confirmation tab of the File Transfer Options dialog box. When it is 
unchecked, you are not warned, and the existing file is automatically overwritten.

· If you click on the Background button in the Copy dialog box, you can work in another application 
while you copy files in the background.

· To disconnect the connected PC once File Transfer is complete, select Disconnect After Transfer in 
the Copy dialog box.

· Only one user can copy files at a time.
· To copy from one location to another on your own PC, use Windows File Manager. 
· You can use the “Drag and Drop” method to copy files. Simply select the file(s) you want to copy, hold

down the mouse button, and drag them to the new location.
· You can compress the files being copied by selecting Use Compression on the Transfer tab of the File

Transfer dialog box. If you are transferring files or data that is already compressed, turn Compression 
off.
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Deleting Files and Directories
The Delete command on the File menu deletes selected file(s) and directories from your own PC or the 
connected PC. 

To delete files or directories:
1. Select the drive and/or directory that contain the file(s) to delete.
2. Select the file(s) to delete. You can select files from only one directory at a time.
3. Choose Delete from the File menu. If you have selected File Delete on the Confirmation Options 

dialog box, a dialog box appears and displays the directory and filename of the first several files and 
directories to be deleted. An ellipsis indicates more files.

4. Choose Yes to delete the file(s) or directories. Each file is displayed as it is deleted. Choose Yes to All
to delete all the files and directories without confirming each one. Choose No to not delete the 
specified file or directory. Choose Cancel to cancel deleting files and exit the dialog box.
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Creating a Folder
The New Folder command on the File menu creates a new folder on your own PC or the connected PC.

To create a new folder:
1. Select the directory where you want to create the new folder.
2. Choose New File, located on the File menu. 
3. A new folder icon appears in the selected directory. Type the name of the new folder.
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Canceling A File Transfer
You can cancel a file transfer as long as your File Transfer window is open. Either user can cancel a file 
transfer.

To cancel a file transfer you initiated:
Choose Abort from the Copy dialog box. The Copy dialog box remains open.

To cancel a file transfer the other user initiated:
Choose Abort from the dialog box that informs you a file transfer is in progress. If your File Transfer 
window is minimized, this dialog box does not appear. When you abort the File Transfer, the connected 
user will see a dialog box stating that the file transfer has been aborted.
If a file is partially sent when the transfer is canceled by either user, it is deleted from the destination PC. 
If a file is being copied to a file with the same name when the transfer is canceled, the file on the 
destination PC may be lost. You can choose Confirm on Replace on the Confirmation dialog box if you 
want the chance to cancel the copy if it will overwrite a file with the same name on the destination PC.
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Refreshing Your File Transfer Window
Use the Refresh command in the View menu to redraw the contents of the File Transfer window.

To update the information in your File Transfer windows:
1. Choose Refresh from the View menu, or press F5

Notes...
· If other applications create, rename or otherwise edit directory information while File Transfer is 

running, your File Transfer windows may need to be refreshed. 
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Drag and Drop Directory and File Synchronization
Another method of directory and file synchronization is drag and drop synchronization. Using this method,
you can quickly synchronize directories and files into a remote or local directory.

To drag and drop synchronize directories and files:
1. Press the ctrl key and select the file(s) or directory you want to synchronize. Hold down the ctrl key 

until all the files you want to synchronize have been selected and dragged to the destination directory.
2. Drag the file(s) or directory to the destination drive and directory while holding down the ctrl key.
3. The Synchronize dialog box appears. Choose Synchronize to begin file synchronization.
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Drag and Drop File and Directory Copy
Another method of file and directory transfer is drag and drop transfer. Using this method, you can quickly
copy files into a connected user’s directory. You can also drag and drop entire directories.

To drag and drop files:
1. Select the file(s) you want to copy. To select one file, click on the file with the mouse cursor. To select 

multiple files in sequence, click on the first file, then hold down shift and click on additional files. To 
select multiple files not in sequence, click on the first file, press and hold down the ctrl key and click 
on the next file you want to select.

2. To transfer an entire directory, simply drag the folder associated with the directory you want to 
transfer, and drop it in the new location. If you have selected the Include Subdirectories option, 
subdirectories in the directory will also be copied.

3. Drag the file(s) to the destination drive and directory.
4. The Copy dialog box appears. Choose Copy to begin file transfer.
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Copying Files in the Background
You can choose to copy files in the background while working in another application.

To copy files in the background:

1. Select the file(s) you want to copy.
2. Select Copy, located on the File menu. The Copy dialog box appears.
3. Click on the Background button. The file(s) will be copied in the background, and you can continue to 

work in another application. You can click the Background button anytime during File Transfer to 
transfer files in the background.
When the file transfer is complete, the Copy dialog box reappears. The information in the Copy dialog
box indicates how much of the selected file was transferred and how long the file transfer took to 
complete.

4. Click on Close to exit the Copy dialog box.
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Synchronizing Files and Directories
Use File Synchronization to synchronize any file or directory between the connected PC’s.

To synchronize one or more files to or from the connected PC:
1. Select the source drive and directory that contain the file(s) to synchronize. Select the file(s) to 

synchronize.
2. Select the destination drive and directory to which you will synchronize files. All files must be 

synchronized in the same directory.
3. Choose Synchronize from the File menu to display the Synchronize dialog box. Click Synchronize. 

The Synchronize dialog box shows the status of the transfer.
4. If the other user’s File Transfer window is open while you are synchronizing files, a dialog box 

appears on the remote PC stating that files are being synchronized. The other user cannot perform 
File Transfer tasks while this dialog box is displayed. This dialog box does not appear if the other 
user’s File Transfer window is minimized.

5. When file synchronization is complete, the Abort button will change to a Close button. This will occur 
only if you have not chosen to automatically close the dialog box after synchronization is complete. 
Click Close to exit the Synchronize dialog box. 

Notes....
· Synchronizing files is a fast and efficient way to update files, because instead of transferring the entire

file or directory, only the new or different file information is transferred to each PC.
· When you select directories to be synchronized, both directories are updated with the most recent 

files from both sides. For example, if you are synchronizing a directory on your PC at home with a 
directory on your PC at work, and the directory on your work PC contains files that are not currently in
the directory on your home PC, the new files from your PC at work will be added to the directory on 
your home PC.

· Files being synchronized are compared by date, time and size to determine if they need to be 
synchronized. If you want to synchronize files that have the same date, time and size, but contain 
different information, select Use Full File Comparison on the Transfer tab of the File Transfer Options 
dialog box. 

· When synchronizing files, make sure the name of the files are exactly the same on both PC’s.
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Automated File Transfer
The Carbon Copy 32 AutoPilot feature allows you to send, receive, and synchronize files and folders 
between your local PC and a remote PC automatically. This feature and the Carbon Copy Scheduler 
allow you to perform unattended file transfer operations. 
Important: Only one AutoPilot task can be active at any time on any one connection.

Setting Up AutoPilot Tasks
You use the AutoPilot Task Wizard to set up AutoPilot tasks. The information you enter into the Task 
Wizard dialog boxes allows you to create a new task.
Important: Since AutoPilot must make a connection to perform the file transfer or file scheduling, you 
must first create a Carbon Copy phone book entry.



To Create a New AutoPilot Task:
1. Double click on the AutoPilot Task Wizard in the AutoPilot tab.

The first Create AutoPilot Task dialog box appears. 
2. In the dialog box, type in a name for the task. Enter a name that helps you remember what this task is

supposed to accomplish. For example, “Update database files”.
3. From the three options listed, select the operation you want to perform. For example, select the 

“Transfer files from a local folder to a remote folder” option to send the database files from your local 
PC to the remote PC.

4. Click on the Next button to continue, or on the Cancel button to cancel the task.
To Select the Folders and Files for the Task:
1. Enter the complete path for the directory on your local PC. 

This directory either contains the files you want to send, or is the destination directory for the files you 
want to receive. For example, C:\DBFILES.

2. Enter the complete path for the directory on the remote PC. 
This directory either contains the files you want to send, or is the destination directory for the files you 
want to receive. For example, 
C:\TRANSFER\DBFILES.
Note that these two paths may or may not be the same.

3. Type in the names of the files that you want to transfer. If you want to transfer several files, separate 
them with a comma. Wildcards are also supported. For example, if you want to transfer all the files, 
you may enter “*.*” in this field. If you want to transfer all your text files, you may enter “*.txt”.
Important: The File Name box is disabled if you have selected “Synchronize a local folder and a 
remote folder” as the operation to perform.

4. Click on the Next button to continue, or on the Cancel button to cancel the task.



To Set the AutoPilot File Transfer Processing Options:
1. Select the file transfer processing options that you want to use.
2. Click on the Next button to continue, or on the Cancel button to cancel the task.
To Set the AutoPilot Lost Connection Options:
1. Select the option to use if the connection is lost during the execution of the task.

Select “Reconnect and Resume Task to copy files a the point where the task failed.
Select “Reconnect and Restart” to recopy all of the files.

2. Click on the Next button to continue, or on the Cancel button to cancel the task.
To Schedule the AutoPilot Task:

Select the Phone Book entry for the task from the drop-down list box , and check the check box if you 
want to add the task to the Carbon Copy Scheduler for execution at a later time. 
If “Add this task to the Schedule” is checked, when you click on the Finish button, Carbon Copy will 
transfer you to the Scheduler dialog box.

3. Click on the Finish button to complete the creation of the AutoPilot task and return to the main user 
interface. The icon for the new task appears in the AutoPilot tab.



Changing AutoPilot Task Options
Once you have created an AutoPilot task, you can change the options that you selected by making 
changes in the Properties tabs for the task.

To access the Properties dialog box for a task:
1. Right click on the task icon in the AutoPilot tab, and select the Properties option on the menu. 

The Properties dialog box for the AutoPilot task appears. This dialog box contains four tabs that 
provide you with the same options that you used to define the AutoPilot task in the Task Wizard.





AutoPilot Properties - Failure Tab
On this tab, you can tell AutoPilot what to do in the event it cannot complete this task. Such a failure may 
occur if the phone line is unexpectedly disconnected or the a busy signal is detected by your modem.
Reconnect and Resume Task – Re-establish the connection and resume copying from where AutoPilot 
left off when the failure occurred.
Reconnect and Restart Task – Re-establish connection and restart the task from the beginning. 
Reschedule Task in n Minutes – Use the Carbon Copy Scheduler to create a new one-time only 
schedule for this task in n minutes. This option will not work if this task was not executed by the 
Scheduler.
Cancel Task – Forget about this task until the next time it is scheduled to execute.



AutoPilot Properties - File Transfer Options Tab
This tab will let you control how AutoPilot will handle certain situations while transferring files. 
Include Subdirectories – Check this box if you want AutoPilot to copy files in subdirectories of the 
source directory.
Overwrite Existing Files – Check this box if you want AutoPilot to overwrite existing files. If this box is 
not checked, existing files will be left untouched.
Overwrite Read-Only Files – Check this box if you want AutoPilot to overwrite read-only files. If this box 
is not checked, read-only files will be left untouched.
Copy Newer Files Only – Check this box if you want AutoPilot to only copy files that already exist in the 
destination directory.



AutoPilot Properties - Operation Options Tab
This tab will allow you to define the operation that this AutoPilot task will perform.
Operation – Select the operation you want this task to perform.

Transfer Files from a Local Folder to a Remote Folder
Transfer Files from a Remote Folder to a Local Folder
Synchronize a Remote Folder and a Local Folder

Local Folder – Enter the name of the folder on the local machine. This is the machine which will execute 
the AutoPilot task.
Remote Folder – Enter the name of the folder on the remote machine.
File(s) – enter a list of one or more file names; separated by commas. You may use filename patterns. 
For example: budget.xls,work*.doc



AutoPilot Properties - Connections Options Tab
This tab will let you select the machine to connect to while this task is executing.
Phone Book Entry – Use this drop-down list box to select a phone book entry to use to make a 
connection.



AutoPilot Wizard - Connection
Select the connection that will be made when this task is executed.
Add This Task to the Schedule – if this box is checked this new task will automatically be added to the 
Carbon Copy Scheduler task list. The Add Schedule Item dialog will pop up and allow you to complete the
schedule for this new task.



AutoPilot Wizard - Failure Options
Select what you want AutoPilot in the event it cannot complete this task. Such a failure may occur if the 
phone line is unexpectedly disconnected or the a busy signal is detected by your modem.
Reconnect and Resume Task – Re-establish the connection and resume copying from where AutoPilot 
left off when the failure occurred.
Reconnect and Restart Task – Re-establish connection and restart the task from the beginning. 
Reschedule Task in n Minutes – Use the Carbon Copy Scheduler to create a new one-time only 
schedule for this task in n minutes. This option will not work if this task was not executed by the 
Scheduler.
Cancel Task – Forget about this task until the next time it is scheduled to execute.



AutoPilot Wizard - File Transfer Options
Select the File Transfer options that you want to be active while this task is executed.
Include Subdirectories – Check this box if you want AutoPilot to copy files in subdirectories of the 
source directory.
Overwrite Existing Files – Check this box if you want AutoPilot to overwrite existing files. If this box is 
not checked, existing files will be left untouched.
Overwrite Read-Only Files – Check this box if you want AutoPilot to overwrite read-only files. If this box 
is not checked, read-only files will be left untouched.
Copy Newer Files Only – Check this box if you want AutoPilot to only copy files that already exist in the 
destination directory.



AutoPilot Wizard - Source/Destination
Enter the name of the local folder, the remote folder and the file(s) to transfer. You may enter multiple files
by separating them with commas and by using filename patterns.
For Example: budget.xls,work*.doc



AutoPilot Wizard
Use the AutoPilot Wizard to create a new AutoPilot task. Enter the name of the task you wish to create 
and the operation you wish this task to perform.



AutoPilot (Automated File Transfer) 
AutoPilot is currently executing a task. Press Abort Task to cancel the currently executing task.



Configuring a Modem
You can make changes to how an installed modem is set up. For example, you can change the 
communications port to which the modem is attached, and modify connection and dialing options.

To configure a modem:
1. Select Communications from the Options menu.
2. Select the type of modem you are using from the list of available connection types. If the modem you 

are using is not in the list of connection types, click the Install Modem button and follow the 
instructions for the Install Modem Wizard.

3. Click on Properties if you want to change any of the settings for the currently selected modem.
4. Choose OK to save your changes.

Notes...
· When selecting a Port, select the port to which your modem or null modem cable is physically 

connected. Do not assign Carbon Copy to a port already in use by a serial printer or mouse.
· For best performance, set the port speed to the highest setting supported by your modem and PC 

hardware. Performance is best at port speeds of 9600 bps or higher.
· For direct connections, the connecting PCs must be set to the same port speed.



Configuring a Network Connection
When you are Waiting for Calls, Carbon Copy will answer a call from another PC. You must exit Wait for 
Call to have Carbon Copy stop answering incoming calls.

To end Wait for Call:
1. Choose Cancel Wait for Call, located on the Connections menu, or click the Waiting button on the 

Carbon Copy toolbar.
The Waiting button on the Carbon Copy toolbar changes to Wait for Call. 

Notes...
· You can use other Windows applications without exiting Wait for Call, but not other Carbon Copy 

utilitiesdef.util.
· When Carbon Copy ends Wait for Call, your modemdef.modem is set NOT to auto-answer, and your 

COM port is released for use by other applications.



Connections Tab
Use the options on the Connections tab to change the Phone Book Entry.

To set options on the Connections tab:
1. In the Properties dialog box for the task, select the Connections tab
2. Select the phone book entry you want from the drop-down list.
3. Click OK to apply the changes you made on this tab, and then select another Options tab. 



Operation Tab
Use the options on the Operation tab to change the type of operation you want to perform and the local 
and remote folders and files.

To set options on the Operation tab:
1. In the Properties dialog box for the task, select the Operation tab
2. Change the type of operation you want to perform.
3. Type in the changes that you want to make to the files.
4. Click OK to apply the changes you made on this tab, and then select another Options tab. 



Transfer Options Tab
Use the options on the Transfer Options tab to change the type of files you want to transfer.

To set options on the Transfer Options tab:
1. In the Properties dialog box for the task, select the Operation tab
2. You can select one or more of the following changes to the transfer options:
· Select Include subdirectories to include all subdirectories contained in the folders you selected earlier.
· Select Overwrite existing files to overwrite any existing versions of the files in the directories where 

the files are being transferred.
· Select Overwrite Read-Only files to update the read-only files with a later version of the file.
· Select Copy newer files only to copy only those files that are a newer version of an existing version
3. Click OK to apply the changes you made on this tab, and then select another Options tab. 



Failure Options Tab
Use the options on the Failure Options tab to specify what action to take if the AutoPilot task fails to 
complete successfully.

To set options on the Failure Options tab:
1. In the Properties dialog box for the task, select the Operation tab
2. You can select one or more of the following changes to the failure options:
· Select Reconnect and Resume Task to reconnect to the remote PC and resume the transfer of files 

from where the failure occurred.
· Select Reconnect and Restart Task to reconnect to the remote PC and restart the transfer of files from 

the beginning.
· Select Reschedule Task in [ ] minutes to specify when you want the transfer of files to start again.
· Select Cancel Task to stop the transfer of files if a failure occurs.
3. Click OK to apply the changes you made on this tab, and then select another Options tab. 



How to Run AutoPilot Tasks
Once you have created a AutoPilot task, you can run the task in one of two ways:
You can run the AutoPilot task manually by double clicking on the AutoPilot task icon. A dialog box 
appears while AutoPilot is running:
- or -
You can schedule the AutoPilot task using the Scheduler feature, as described in the following section.



Scheduling AutoPilot Tasks
You use the Carbon Copy Scheduler to schedule AutoPilot tasks. The scheduler allows you to schedule 
the AutoPilot tasks or other applications.

To Add a New AutoPilot Task to the Scheduler:
1. Click on the Carbon Copy Scheduler icon.

The Carbon Copy Scheduler dialog box appears. 
Uncheck the “Enable Scheduler” box to disable the Scheduler.
Check the “Load Scheduler before the login prompt” box to allow scheduled tasks to run while the PC
is not logged in.

2. In the Scheduler dialog box, click on the Add button
The Add Schedule Item dialog box appears.

3. In the Add Schedule Item dialog box, click on the browse button to select the task you want to 
schedule.

4. Use the comment box to enter a comment about the task you want to schedule.
5. Type in the time of day that you want the task to be performed.
6. Select the frequency of the task.

If you select once, either click on the Today option, or select the Date option and type in a date when 
you want the task to be performed. 
If you select daily as the frequency, options appear that allow you to specify every weekday or some 
daily interval (such as every 3 days). 
If you select Weekly as the frequency, options appear that allow you to specify weekly intervals and 
specific days of the week. For example, you could specify every 2 weeks on Monday, Wednesday, 
and Friday.
If you select monthly as the frequency, options appear that allow you to specify the day of a monthly 
interval (such as the 12th day of every 2 months), or the specific weekday of a monthly interval. For 
example, the second Sunday of every 2 months.

7. Click the OK button. The Carbon Copy Scheduler dialog box appears with the new task listed.
If you want to make changes to the scheduled task, highlight the task and click on the Modify button.
If you want to delete an AutoPilot task, click on the checkbox for the task, and click on the delete 
button.

8. Click on the Hide button to hide the Scheduler user interface.
9. If you exit the scheduler, no AutoPilot tasks can be run.



Carbon Copy Scheduler
The Carbon Copy Scheduler allows you to schedule the automatic execution of AutoPilot Tasks. It may 
also be used to schedule the launch of any file in the system.
Hide – The Hide button is used to hide the Carbon Copy Scheduler interface. The Scheduler will continue
running and may be accessed by double-clicking on the scheduler icon in the system tray.
Exit – The Exit button will cause the Scheduler to stop running. Any scheduled tasks will not be executed 
until the Scheduler is started again.
Add – The Add button is used to add a file to the scheduled task list. This button will pop up the Add 
Schedule Item dialog.
Modify – The Modify button is used to modify the currently selected    item in the scheduled task list. This 
button will pop up the Modify Schedule Item dialog.
Delete – The Delete button is used to delete the currently selected item in the scheduled task list.



Scheduler Add/Modify Schedule Item Dialog
The Add Schedule Item dialog allows you to add a new item to the scheduled task list or modify an 
existing item.
Item to Schedule – Enter the name of the file to schedule in this edit box.
Browse – Browse is used to browse your drives for the file to schedule.
Comment – Enter a comment meaningful to you in this edit box. This comment will be displayed in the 
Carbon Copy Scheduler task list for your convenience.
Time – Enter the time of day that you want this file to be executed.
Frequency – Select the frequency of execution. Once, daily, weekly or monthly.
Once – Select Today or a specific date for a one time only execution. After the file has been executed, it 
will be removed from the task list.
Daily – Select execution every n days or every weekday.
Weekly – Select the days of the week that the file should be executed.
Monthly – Select execution on a certain day number or on the nth day of the week.



Copy
Use this dialog box to copy files from your PC to the remote PC, or vice versa. 
Choose Copy to begin copying. The status of the Copy is displayed as the files are copied.
From Folder - Displays the full path name of the directory from which files are currently being copied.
To Folder - Shows the directory to which the files are being copied.
Current File - Displays the name of the file currently being copied.
Copy List - Shows the name of each file to be copied. If you have chosen to copy subdirectories, files in 
the subdirectories will also be listed.
Remove from Copy List - Click to remove the currently highlighted file from the Copy List. When you 
remove a file from the Copy List, it will not be copied.    You may highlight multiple files.
Files Remaining - Shows the number of files remaining to be copied.
Files Complete - Shows the number of files already copied.
File Size - Shows the size in bytes of the file being copied.
Bytes Sent - Shows the total number of bytes sent.
Transfer Time - Shows how much time has elapsed since file transfer began.
Throughput (CPS) - Shows the current effective throughput in characters per second.
Percent of Current File Complete - Shows what percentage of the file currently being copied has been 
sent.
Percent of All Files Complete - Shows what percentage of all the files to be transferred has been sent.
Background - Allows you to synchronize files in the background. File Transfer will appear as an icon at 
the bottom of your screen. You can use other applications while Carbon Copy is synchronizing files.



Confirmation Tab
Select the actions that you want confirmed during File Transfer. 

Confirm on File Delete
Confirm on File Delete is selected by default. When Confirm on File Delete is selected, you are asked for 
confirmation when you choose a file to delete.

Confirm on Folder Delete
Confirm on Folder Delete is selected by default. When Confirm on Folder Delete is selected, you are 
asked for confirmation when you choose a folder to delete.

Confirm on File Replace
Confirm on File Replace is selected by default. When Confirm on File Replace is selected, you are asked 
for confirmation before a file being replaced is allowed to overwrite an existing file with the same name.

Confirm on Folder Copy
Confirm on File Copy is selected by default. When Confirm on File Copy is selected, you are asked for 
confirmation before a file being copied is allowed to overwrite an existing file with the same name.

Confirm on Folder Synchronize
Confirm on Folder Synchronize is selected by default. When Confirm on Folder Synchronize is selected, you are asked for 
confirmation before a folder being synchronized is allowed to overwrite an existing folder with the same name.



Include Tab
Use the options on this tab to select the types of files that will be displayed in the File Transfer window.

Name Field
Displays all files with the specified name or extension. You can use wildcard characters in this field. Use 
the ? character to represent any character. Use the * character to represent a series of characters.

Programs
Displays all files that have an .EXE, .COM, .PIF, or .BAT extension.

Documents
Displays all files that are associated with an application.

Other Files 
Displays all other files.

Show Hidden/System Files
Displays hidden and system files.



Directory Restrictions Tab
Use the options on this tab to restrict any connected users access to selected directories. You can select 
entire directories.
1. Select the directories that you want to restrict access to. Click the Restrict/Allow Access button. A 

symbol will appear on the selected directories, indicating that access has been restricted. Connected 
users will not be able to access these directories.

2. To remove access restrictions from selected directories, click the Restrict/Allow Access button again.
3. Click Apply to apply the changes you made on this tab and then select another File Transfer Options 

tab. Or, click OK to save your changes, or Cancel to cancel your changes and exit the dialog box.



Communications Dialog Box Connections Tab
This tab contains a list of devices you can use to make a connection.
To see a description of the device, highlight the device name. A description appears in the Description 
section of the dialog box.
If the type of modem you will be using to make a connection is not listed here, click Install Modem to 
begin the Modem Installation Wizard. To view or change the properties of a device, highlight the device 
name and click Properties.



Communications Dialog Box Wait for Call Tab
To select devices to wait for incoming calls:
1. Select the devices that you want to wait for call on by clicking the box next to the device name. You 

can select multiple devices. For example, you may want to select the type of modem you have 
connected to your PC, and your network type. Incoming calls will be able to come from either the 
modem, or over the network.    You may have to scroll the box down to see all the devices listed.

2. If you select TCP/IP, you can select the method to use when other PC’s are browsing for Carbon 
Copy users set to Wait for Call. Local Network Broadcasts is selected by default. This method may 
not detect your PC if it is located behind a firewall. 
Select Use the Internet if your PC is connected to the Internet and you want to allow access to your 
PC by users located outside your local network.    Both Microsoft and Microcom maintain Internet 
Locator Servers that allow users to contact one another on the Internet.    By selecting Use the 
Internet, you are registering your PC with one of those servers, and your PC will be visible to other 
Carbon Copy users who are browsing via ILS.
After you select Use the Internet, Carbon Copy will Wait for Call on all the servers listed in the 
Internet Locator Servers list box.

3. To add an ILS, click the Add button. The Add Internet Locator Servers dialog box appears. Enter the 
full address of the Internet Locator Server your PC is located on. An example of an ILS address is: 
uls2.microsoft.com/scripts/ulserver.dll. You must enter the server location (uls2.microsoft.com is the 
server location in the above example). If you do not enter the other parts of the address, the defaults 
shown in the above example will be used. When you are done adding the ILS, click OK.
To remove an ILS, highlight the ILS from the list of Internet Locator Servers and click the Remove 
button. The ILS will be removed from the list without asking you for confirmation. 
When you add or remove an ILS, the ILS will also be added to or removed from the list of ILS entries 
on the Browse tab.

4. Select Wait for Call on Startup if you want Carbon Copy to automatically be set to wait for calls the 
next time you start it.

5. Select Minimize on Wait for Call if you want Carbon Copy to run minimized when you wait for calls.
6. When you are done selecting devices, click OK to save your changes and exit the dialog box. Click 

Cancel to exit the dialog box without saving your changes.



Communications Dialog Box Workstation Tab
The settings on this tab determine how your PC is identified on the network.

To configure Workstation tab settings:
1. The Workstation Name field identifies your computer on the network when it is set to Wait for Calls. 

This is the name other users will see when they browse for Carbon Copy users on the network. If you 
do not want the name of your PC to appear, deselect the Publish Workstation Name box. Other 
users will still be able to connect to your PC by manually entering your workstation name in the 
Connect dialog box.

2. In the Connect Timeout list box, enter a number, in seconds, for how long Carbon Copy will wait for 
a response from the other PC after dialing, before it times out and hangs up. The range is 5 to 225 
and the default is 90.

3. Click OK to save your changes and exit the dialog box, or click Cancel to exit the dialog box without 
saving your changes.



Communications Dialog Box Browse Tab
Browsing allows you to automatically search for other Carbon Copy users set to Wait for Call on the 
network. 
Using the settings on the Browse tab, you can select the types of connections to look for while browsing 
for other Carbon Copy users and select a method to use while browsing for TCP/IP connections. You can 
also choose to browse automatically when you start Carbon Copy, and specify workstations to browse for.

To configure Browse tab settings:
1. In the Browse section, select the type of connections to look for while browsing on a network.
2. If you select TCP/IP connections in the Browse section, you can select the method to use while 

browsing for Carbon Copy users. Local Network Broadcasts is selected by default. This method 
may not detect Carbon Copy systems running behind firewalls. 
Select Use the Internet if your PC is connected to the Internet and you want to allow access to your 
PC by users located outside your local network.    Both Microsoft and Microcom maintain Internet 
Locator Servers that allow users to contact one another on the Internet.    By selecting Use the 
Internet, you are registering your PC with one of those servers, and your PC will be visible to other 
Carbon Copy users who are browsing via ILS.
After you select Use the Internet, Carbon Copy will browse on all the servers listed in the Internet 
Locator Servers list box.

3. To add an ILS, click the Add button. The Add Internet Locator Servers dialog box appears. Enter the 
address of the Internet Locator Server you want to browse for Carbon Copy users. An example of an 
ILS address is: http://uls2.microsoft.com/scripts/ulserver.dll. You must enter the server location 
(uls2.microsoft.com is the server location in the above example). If you do not enter the other parts of 
the address, the defaults shown in the above example will be used. When you are done adding the 
ILS, click OK.
To remove an ILS, highlight the ILS in the list of Internet Locator Servers and click the Remove 
button. The ILS will be removed from the list without asking you for confirmation. 
When you add or remove an ILS, the ILS will also be added to or removed from the list of ILS entries 
on the Wait for Call tab.

4. Select Browse on Startup if you want Carbon Copy to automatically search for PCs for you to 
connect to when you start Carbon Copy. PCs that are available for you to connect to will appear on 
the Network tab.

5. In the Browse Workstation Names field, enter the name of the PC you want displayed on the 
Network tab. You may want to do this if you will be connecting to a specific PC and want to know 
when it is available to connect to. You can use wildcards in this field. Use the ? character to represent 
any character and use the * character to represent a series of characters.

6. Click OK to save your changes and exit the dialog box, or click Cancel to exit the dialog box without 
saving your changes.



Uninstall
Use the options on this dialog box to remove Carbon Copy 32 from your PC.
1. Select the user files you want to remove. If you will be reinstalling Carbon Copy and want to use your 

old User Profiles, AutoPilot, or Phone Book settings, deselect User Profiles or Phone Book. 
You can also choose to delete the read only and hidden files associated with Carbon Copy. By 
default, all the file types are selected.

2. Click OK to delete the selected Carbon Copy utilities, or click Cancel to cancel the uninstall.
3.  If you click Cancel, another dialog box appears. Click Yes to cancel the uninstall, or No to continue 

with the uninstall.



Browse
Click on the Browse button to locate the path and directory of the file you want to locate.



File Synchronize
The options on the Synchronize dialog box allow you to synchronize files on the local PC with files on 
the connected PC.

The Background button allows you to synchronize files in the background. File Transfer will appear as an
icon at the bottom of your screen. You can use other applications while Carbon Copy is synchronizing 
files.
From Folder - Shows the full path name of the directory from which files are being synchronized. 
To Folder - Shows the full path name of the directory to which files are being synchronized.
Current File - Displays the name of the file currently being synchronized.
Synchronize List - Displays a list of files that will be synchronized. If you have chosen to synchronize 
subdirectories, files in the subdirectories are also listed.
Remove from Synchronize List button - Removes the currently highlighted file from the Synchronize 
List. If you remove a file from the Synchronize List, it will not be synchronized.
Files Remaining -    Shows the number of files left to be synchronized.
Files Complete    - Shows the number of files that have already been synchronized.
File Size - Shows the size in bytes of the file currently being synchronized.
Bytes Sent - Shows the total number of bytes compared.
Transfer Time - Shows how much time has elapsed since the file synchronization began.
Throughput (CPS) - Shows the current effective throughput in characters sent per second.
Percent of Current Files Complete - Shows what percentage of the file currently being synchronized 
has been sent.
Percent of All Files Complete - Shows what percentage of all the files to be synchronized has been sent.



Sync in Progress
Files are currently being synchronized. Select Cancel to cancel the file synchronization in progress, or click Close to exit the 
dialog box and continue with the file synchronization.

When you select Cancel, the remaining files will not be synchronized, and any partial synchronizations 
will be deleted.



Transfer Options
Use Full File Comparison

This option compares files that have the same date, time and size. The files are checked to see if they 
contain different information, even though they have the same date, time and size.

Close Dialog After Transfer
This option automatically closes the Copy dialog box after a file transfer or file synchronization is 
complete. 

Disconnect After Transfer
This option automatically disconnects the attached PC after the file transfer or file synchronization is 
complete.

Include Subdirectories
This option includes any subdirectory in a file transfer or file synchronization. If you do not select this 
option, subdirectories will not be transferred or synchronized.

Enable Crash Recovery
This option allows you to continue with a file transfer or synchronization even if you have lost the 
connection with the remote PC. The next time you start the file transfer or synchronization, simply select 
the same file(s) and restart the transfer. Carbon Copy will automatically resume the transfer at the point 
where the connection with the connected PC was lost. This option is selected by default.

Copy Existing Files Only
This option copies only the files that already exist on the connected PC. For example, if you choose to 
copy a file, but a file with that name does not already exist on the connected PC, the file will not be 
copied.

Use Compression
This option enables the amount of compression during File Transfer.

Copy Empty Directories
This option copies empty directories to the connected PC. The new, empty directory is created on the 
connected PC. 

Copy Newer Files Only
This option copies only the files with a more recent date than files with the same name on the connected 
PC.

Overwrite Read Only-Files
This option allows read-only files on the destination PC to be overwritten.



Crash Recovery
The Enable Crash Recovery option, located on the Transfer Options dialog box, allows you to continue 
with a file transfer or synchronization even if you have lost the connection with the remote PC. The next 
time you start the file transfer or synchronization, simply select the same file(s) and restart the transfer. 
Carbon Copy will automatically resume the transfer at the point where the connection with the remote PC 
was lost. 



Voice Chat
The Voice Chat feature of Carbon Copy 32 allows connected Carbon Copy users to talk to each other 
even while they run Remote Control, File Transfer, Remote Clipboard, or any other Carbon Copy 
applications.
Voice Chat is useful in technical support situations where there is only one phone line available for a 
modem connection or over the Internet. A support technician can use remote control to troubleshoot a 
problem on a user’s PC while talking to the user in Voice Chat.
Voice Chat can also be used stand-alone as an Internet phone utility that allows you to have live 
conversations over the Internet.
Any number of Carbon Copy users, connected to a central Carbon Copy PC, can chat with one another 
like a telephone party line.
You must have a sound card, speakers, and a microphone on each PC to use Voice Chat. If a PC is not 
properly equipped, you can still use text Chat. Voice Chat is not supported for versions of Carbon Copy 
earlier than Version 5.0. These versions use text Chat.
When Voice Chat is active, it filters out background noise, so little or no audio data is sent when a user is 
not speaking. 
Important: During a voice chat session, the quality of the audio heard by either user may decrease as 
more Carbon Copy applications are used, or while the applications are performing data-intensive tasks.



Setting Voice Chat Options
Before you can use Voice Chat, you need to set the audio input and output options. Carbon Copy also 
allows you change the setting during a voice chat session.

To set Voice Chat options:
1. Click on Options in the Carbon Copy 32 main menu, and select Voice Chat from the drop-down list.

The Voice Chat Options dialog box appears. This dialog box contains three tabs: Output, Input, and 
General. The Output tab is the default tab.

To Select the Output Options:
1. In the Output tab, select your Output Audio Device from the drop-down list.
2. Click on the Play Sample button to hear the current volume of a 10 second sound clip.
3. Click on the volume control slider button, and hold the left mouse button down as you move the slider 

button to raise or lower the volume.
You can click on the Play Sample button again to test the change in volume.

To Select the Input Options:
1. Click on the Input tab. The Input tab appears.
2. Select the Input Audio Device from the drop-down list.
To Set the Input Level:
1. In the Set Input Level section of the dialog box, select either Use Automatic Setting or Use Manual 

Setting.
If you select Use Automatic Setting, click the Configure button. The Configure Input Level dialog box 
appears.

2. In the Configure Input Level dialog box, click the Start Sampling button. 
Speak in a normal voice for the duration of this test. Carbon Copy samples your voice to set the input 
level. When the sample is completed, the Input Level track bar in the Input tab is adjusted to the 
correct level.

3. If you select Use Manual Setting, click the slider button on the Input Level track bar, and hold the left 
mouse button down as you move the slider button to increase or lower the input level. To increase the
sensitivity of the microphone, increase the input level on the track bar, to decrease the sensitivity, 
decrease the input level.

To Set the Background Noise Suppression Level
1. In the Set Background Noise Suppression Level section of the tab, select either Use Automatic 

Setting or Use Manual Setting.
2. If you select Use Automatic Setting, click the Configure button. The Configure Background Noise 

Suppression dialog box appears
3. In the Configure Background Noise Suppression dialog box, click on the Start Sampling button.

Important: Do not speak for the duration of this test. Carbon Copy is sampling the background noise.
The background noise is sampled for up to 20 seconds. When the sample is completed, the Noise 
Suppression Level track bar in the Input tab is adjusted to the correct level.

4. If you select Use Manual Setting, click the slider button on the Background Noise Suppression Level 
track bar. To filter out more background noise increase the background noise suppression level 
setting; to filter out less, decrease the setting.

5. When you have finished selecting options in the Input tab, click the OK button.
To Select the General Options:
1. In the General tab, select the audio file you want to hear when another user connects with you from 

the Audio File drop-down list
In the User Name field, you enter the user name that will be displayed to other conference 
participants.

2. Click the Disable Audio checkbox, if you do not want Carbon Copy to use your system’s audio 
devices.

3. Click the Force half-duplex if you want only one person to speak at a time.
4. When you have selected the options you want to use, click the OK button.





Voice Chat General Tab
Carbon Copy voice chat alerts you of incoming calls with an audio announcement.    You can select and 
test which .Wav file to play when a voice chat connection is being requested
Choose a user name to be displayed to conference participants.    The default is your computer's name.
The disable audio checkbox stops all incoming and outgoing audio features of the voice chat application
Carbon Copy is a full duplex application (record and play simultaneously), however, not all audio cards 
support this feature.    You can select "force half duplex" to enable a voice chat session on these cards.
Press Apply or OK to save these settings



Voice Chat Options Output Tab
Select the output device that Carbon Copy will use for voice chat 
Test you audio output with the play sample button and set the desired volume level
Press Apply or OK to save these settings



Voice Chat Options Input Tab
Select the input device that Carbon Copy will use when running voice chat 
The input level can be adjusted automatically or manually
· When selecting automatic configuration, press the "Configure" button to determine the correct input 

level for your specified microphone/soundcard
· If you prefer to set the level manually, move the slider to the desired level

The background noise level can be adjusted automatically or manually
· When selecting automatic configuration, press the "Configure" button to determine the correct 

background noise level for your specified microphone/soundcard
· If you prefer to set the level manually, move the slider to the desired level

Press Apply or OK to save these settings



Starting a Voice Chat Session
Carbon Copy 32 Voice Chat allows you to talk to a Carbon Copy user as if you were both using the 
telephone. You must be connected to another Carbon Copy user before you can use Voice Chat. 

To Start a Voice Chat session:
1. While connected to another Carbon Copy user, click on the Chat button in the tool bar, or double click 

on the Voice Chat icon.
A Voice Chat dialog box appears with the message: “Waiting to join (username) conference.”
The user called must respond to the chat request by clicking OK.
The Voice Chat dialog box appears

2. In the Carbon Copy Voice Chat window, click the slider button to adjust the speaker volume or the 
microphone sensitivity.

3. Click on Options, and select Mute Speakers or Mute Microphone if you want to mute these devices. 
You can also use the Mute checkbox to do this.
You are now in Voice Chat. Everything you say will be sent to the other user’s speakers, and 
everything the other user says will be sent to your speakers.
If your sound card does not support full-duplex operation, then red and green status lights will appear 
in the upper right-hand corner of the Voice chat dialog box. When the green status light is on, your 
voice is transmitted to the other user. When the red light is on, the other user is speaking to you, and 
your voice will not be transmitted. 
While in Voice Chat, you can also type text messages to all connected users. To do this, click on the 
edit box at the bottom of the Voice Chat dialog box, and type your message. When you press Enter, 
your text message will be sent to the other user.

4. Click on File and select the Exit option from the menu when you want to end your Voice Chat session.
5. Click on the Chat icon in the toolbar to exit Voice Chat

- or -
Click the close button in the upper right corner of the Voice Chat window.



Starting a Voice Chat Conference Session
Carbon Copy 32 Voice Chat allows you to set up a multiple user Voice Chat conference session. In a 
Voice Chat conference session, the first PC that is connected to becomes the conference server. Other 
users can then connect to this conference PC and launch Voice Chat
For example, if User 1, User 2, and User 3 want to establish a Voice Chat conference, User 1 connects to
User 3, and launches Voice Chat. User 3 automatically becomes the conference server. User 2 can now 
connect to User 3 and launch Voice Chat.
In this configuration, voice can be sent and heard by all three users.
A common use for voice conference is the teacher - student scenario. In this scenario, multiple users can 
connect to and remotely control a single host (teacher) PC. The teacher can be demonstrating 
applications on his desktop while speaking to the other parties.
Both the conference server PC and the guest PCs should have Voice Chat set to full duplex. This allows 
several users to speak at the same time. If one PC in a conference session is configured for half duplex, 
then all conference members’ PCs will be forced to use half-duplex as well. You may wish to use half 
duplex Voice Chat to limit the amount of data being transferred. This may increase the performance of 
your session.
Carbon Copy users who do not have the Voice Chat utility can connect to one or more of the guest PCs 
and use the Text Chat utility.
Voice Chat can be run at the same time as all other Carbon Copy utilities.

To Start a Voice Chat Conference Session:
1. User 1 sets Carbon Copy to Wait for Call.
2. Others users call in to and connect to User 1.

Important: Users may establish connections with the Voice Chat conference server using any 
connection method including modems, IPX, TCP/IP, direct connection, and dial-up networking.



Text Chat
Chat allows you to "converse" with the other user onscreen. Typing done by either user appears on both 
PC’s. 

To chat with a remote PC user:
1. Select Chat, located on the Utilities menu, or click the Chat button on the Carbon Copy toolbar. A 

dialog box appears telling you that you are requesting to Chat with the other user.
2. The other user sees a dialog box saying that you want to Chat, and their response determines what 

happens now:
- If the other user chooses OK, the Chat window appears on both screens and Chat begins.
- If the other user chooses Cancel, your request to Chat is denied. 
- If the other user does not respond within 30 seconds, your request to Chat is denied.
You can also cancel your request to Chat before the other user responds.

Notes...
· Whatever you type appears in the My Computer section of the Chat dialog box. Whatever the other 

user types appears in the other section of the Chat dialog box. The cursor in your local dialog box 
indicates where the next character you type will appear. 

· You can use any printable ASCII characters, plus CTRL+G (beep) and the DELETE key. You cannot 
use Edit menu commands to edit the Chat text itself.

· Older text that scrolls out of view is held in each Chat window, and you can scroll to see it.
· If the other user’s Chat window is not active, any Chat text you send is ignored. You will hear a beep 

when you type, but the other user will not know you are sending Chat text.
· You can copy Chat text into the Windows Clipboard, using the Copy command in the Edit menu.
· You can paste text into the Chat window from the Windows clipboard, using the Paste command in 

the Edit menu. 
· The Clear Windows command in the Edit menu clears the Chat windows on your PC, for a fresh start 

in accumulating text you may later copy.
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Copying and Pasting Chat Text
You can copy Chat text into the Windows Clipboard, and later paste it into other applications. Also, you 
can copy text from an application into the Windows Clipboard, and paste it into the Chat window.

To copy the Chat text to the Windows Clipboard:
1. Make your Chat window active.
2. Choose Copy from the Edit menu.

To paste text from the Windows Clipboard into the Chat window:
1. Make your Chat window active.
2. Choose Paste from the Edit menu.

Notes...
· The Clear Windows command in the Edit menu clears all text from your Chat windows.
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Clearing Your Chat Windows
The Clear Windows command in the Edit menu empties the windows that hold Chat text on your PC. 

To clear your Chat windows:
Choose Clear Windows from the Edit menu.

Notes...
· Clear Windows deletes not only visible text, but also any text that may have scrolled out of view. 
· Use this command to provide a clear screen for Chat text that will be copied later to the Windows 

Clipboard. Because the entire contents of both windows are copied, you may want to empty them 
before typing or receiving Chat you may later copy.

· Clear Windows does not affect the Chat windows on the remote PC.
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Dialing Phone Book Entries
To dial a Phone Book entry:
1. Display the Phone Book tab.
2. Double click the desired Phone Book icon

or
3. Highlight the Phone Book icon you want to call.
4. Click the Call button, or select Place a Call from the Connections menu. The Connect dialog box 

appears.
5. Click Connect. The connection is started. When you call a Phone Book entry with a login name and 

password, they are sent automatically. Otherwise, if the PC you are calling asks for your login name, 
enter it (and your password if needed), and choose OK.

Notes...
· When you select a Phone Book entry and type in a phone number manually, the entry login name and

password are still sent. Use this feature if the PC in your Phone Book is mobile, or temporarily at a 
different number.
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Protecting Your Phone Book
Phone Book Security determines whether an access password is needed to view and edit your Phone 
Book, and what that password is. 

To require an access password for your Phone Book:
1. Open the Security dialog box, located on the Options menu.
2. Type a password in the Security Password field.
3. Select Phone Book.
4. Click OK. You will be asked to confirm your password. Type the password exactly as you did the first 

time.

To change the existing access password for your Phone Book:
1. Open the Security dialog box, located on the Options menu.
2. Enter your new password in the Security Password field.
3. When you enter a new access password and choose OK, you will be asked to type it again for 

verification. Type the access password exactly as you did the first time, and choose OK.

To disable password protection for your Phone Book:
1. Open the Security dialog box, located on the Options menu.
2. Deselect the Phone Book check box.

This allows unprotected access to your Phone Book. 

Notes...
· If you want to control who can open and edit your Phone Book (including connected users during 

Remote Control), set an access password. An access password is not required by default.
· Your access password may include any displayable characters (including spaces), and is NOT case 

sensitive. It is always shown as asterisks. Use an access password you will remember, or you will not 
be able to edit your own Phone Book.
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Using Dial Modifiers
Dial modifiers are command characters imbedded in a phone number that cause the modem to dial in a 
special way. Carbon Copy accepts dial modifiers when entered manually or used in a Phone Book entry. 
Which commands are supported and how the modem responds to them depends on the modem. The 
examples given here are from the Hayes factory defaults. The manual for your modem will tell you its 
default settings, and how to change them.

Examples of dial modifiers:
T T means touch-tone dial the characters that follow. Tone dial is the default, so you do not need T 

unless you have previously used P (Pulse Dial). You can use both T and P in the same number. 
P555-1234 T5678 pulse dials 5551234 and tone dials 5678 (an extension).

P P means Pulse Dial the characters that follow. See T, above.
@ @ means wait 5 seconds longer than the length of time set in the modem’s S7 register. Carbon Copy 

sets this to 30 seconds when it configures your modem. 5551234 @ 5559876 dials 5551234, waits 35
seconds, and dials 5559876.

, A comma means pause for the time set in the modem’s S8 register. Carbon Copy sets this to 2 
seconds when it configures your modem. You can use more than one comma for a longer pause. This
is often used to dial out of a switchboard. 9,555-1234 dials 9, pauses 2 seconds, and dials 5551234.

! An exclamation point means a hook flash, sometimes used to transfer a call. The modem will go on 
hook for 1/2 second, and go back off hook, as if you pushed the switch-hook button on your 
telephone. The effect of this depends on your switchboard. 5551234!232 dials 5551234, goes on 
hook for 1/2 second, goes back off hook and dials 232.

{button ,AL(`addphonebook',0,`',`')}    Related Topics



User Profiles Introduction
The User Profiles tab contains a list of profiles for each user who may connect to your PC. You create 
User Profile entries using the Create New User Wizard on the User Profiles tab. User Profiles contain a 
customized configuration for each user who has access to your PC, and can include information such as 
login names, callback phone numbers and login passwords that prevent unauthorized access to your PC. 
Using these features, you can protect access to your PC by requiring callers to provide a valid login name
before establishing a connection. If someone calls your PC using a login name that has a callback 
number associated with it, your PC hangs up and calls back the number specified in the User Profile. This
ensures that the calling PC is at the location and phone number you expect. It also allows a caller to 
reverse the phone charges to the answering PC.
If security is not required, you can disable callback phone numbers and login information. This is the 
default. 
You may set an access password on the Security Options dialog box to protect your User Profiles from 
unauthorized users. This is useful to prevent Guest users from editing your User Profiles during Remote 
Control. All information in the User Profiles is encrypted when it is stored to disk, so that anyone browsing 
through your files cannot open the User Profiles file and view its contents. 
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Displaying the User Profiles Tab
You can display your User Profiles tab during a connection, or while using other Carbon Copy utilities.

To display your User Profiles tab:
1. Click on the User Profiles tab in the main Carbon Copy window. The User Profiles tab appears.
2. If you set an access password for your User Profiles tab on the Security Options dialog box, the first 

time you create a new User Profile, or select a User Profile icon, a dialog box appears. By default, no 
access password is required.

3. Enter the access password for your User Profiles tab, if there is one, and choose OK.
If the password you enter is incorrect, you cannot display your User Profiles tab. Return to step 1 and 
try again.

Notes...
· The first time you access the User Profiles tab, only the Create New User and Default User icons will 

appear.
· You can require anyone attempting to open your User Profiles tab to provide a valid access 

password. An access password is NOT required by default. 
· Note that a connected user may edit your User Profiles during Remote Control, unless you set an 

access password for it.
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The Default User
The User Profiles tab contains a Default User icon. This icon represents the access rights that another PC
has on your PC when you make a connection to it. For example, you make a connection to a PC called 
DemoPC. The Default User settings indicate which Carbon Copy utilities DemoPC will be able to access 
on your PC while you are connected to it.
By default, the connected user will be able to access all the Carbon Copy utilities except for your Phone 
Book, User Profiles and Security Options dialog box. You can change the settings for the Default User the
same as you would for any other user. 



Adding a New User Profile
Each User Profile must include a user name. It may also include a login password and callback phone 
number. If the Require Logins checkbox on the Security dialog box is selected, all callers are prompted to 
enter a login name. If a Callback Phone Number is selected for a caller, your PC hangs up and calls back 
the number when the caller establishes a connection.

To add a new User Profile:
1. Click on User Profiles to display the User Profiles tab.
2. Double click on the Create New User icon, or select Create New User from the File menu.

The first Create New User Wizard dialog box appears. Click Next to continue.
3. In the User Name text box, type a name for the user who will access your PC. Each entry must have 

a User Name. 
If you want the caller to provide a password to gain access to your PC, select the Login Password text
box and type a login password. By default, the login password must be at least 6 characters long. The
login password is displayed as asterisks as you type. In the Confirm Password text box, type the login
password again exactly as you typed it the first time. 
If you do not require the caller to provide a password to log on to your PC, leave the Login Password 
text box blank.
Click the Next button to continue.

4. If you want your PC to hang up and call back a specified number when the caller establishes a 
connection, select one of the following callback types.
None: No callback is performed. This is the default.
Fixed: Call the PC at the number specified in the Callback Phone Number field. You must enter a 
phone number in the Callback Phone Number field when you select Fixed.
Roving: When you select Roving, entering a phone number in the Callback Phone Number field is 
optional. If you enter a number in this field, it becomes the default number. When the user who 
originates the call dials in, the default call back number, if supplied, appears in the Roving Callback 
dialog box. The connection can be made using this phone number, or users can change this number 
if they are at a different location.
Passthrough: Passthrough works in the same way as Roving Callback, except you are given the 
additional option of completely bypassing the callback by pressing P when the Callback dialog box 
appears.
After selecting a callback type, click the Next button to continue.

5. Select the Carbon Copy applications that the user will have access to when connected to your PC. By
default, all the applications are selected except for the Phone Book, User Profiles and the Security 
Options dialog box. Click the Next button to continue.

6. The final dialog box appears, telling you that you have successfully created a new Carbon Copy user. 
If you want to make any changes to this connection now, click the Back button. Your changes are 
saved when you click the Finish button.
To add another entry, return to step 1.

Notes...
· You can change the required length of the login password on Logins tab, on the Security Options 

dialog box.
· User Profiles login names and login passwords may contain any displayable character (including 

spaces), and are NOT case sensitive. Callback phone numbers may include digits from 0-9, the * 
(asterisk) and # (pound sign), and dial modifiers supported by your modem (such as a comma for a 
pause). You may add characters such as hyphens and spaces to make the phone number more 
readable. Carbon Copy will accept up to 38 phone number characters, but some modems have lower 
limits.

· You can edit a User Profile during a connection, or while using any other Carbon Copy utilities.
· The fact that login passwords are not displayed provides added security for your PC. Login names 

you assign are visible in any user's Phone Book that has an entry for you. Login passwords always 
show as asterisks. You cannot guarantee that everyone who puts you in their Phone Book will restrict 
access to it, even though they could. Because of this, it's best to assign a login password for each 



login name if security is important.
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Editing User Profiles
To edit a User Profile:
1. Display the User Profiles tab.
2. Select the User icon you want to edit. Select Properties, located on the File menu. The Property 

dialog box for the selected User icon appears.
3. On the Login tab, you can change the name or password for the selected user. Edit the entry. To 

change the name or password, simply type the new name or password in the correct field. If you enter
a new password, retype it in the Confirm Password field exactly as you did the first time.

4. Select the Callback tab. On the Callback tab, you can change the callback type for the selected user. 
You can also change the callback phone number.

5. Select the Profile tab. On the Profile tab, you can select the Carbon Copy applications the user will be
able to access when they connect to your PC. By default, all the applications are selected except for 
the Phone Book, User Profiles and the Security Options dialog box.

6. When you are done making changes, click OK to close the dialog box and save your changes. Click 
Cancel if you want to exit the dialog box without saving any of your changes. 
To edit another entry, return to step 1.
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Roving Callback
Enter the phone number you want to be called back at in this field. If you have already entered a 
default callback phone number, it will appear automatically in this field. If you enter a new phone 
number in this field, it will become the default callback number, and will be used the next time you 
make a Roving Callback connection.



Managing User Profile Icons
Each User Profile entry you create is represented by an icon. You can delete, rename and change the 
way User Profile icons are displayed.

To delete a user icon from the User Profiles tab:
1. Display the User Profiles tab. 
2. Highlight the User icon you want to delete and select Delete, located on the File menu, or highlight 

the icon and press the right mouse button. Select Delete.
3. A dialog box will appear, asking if you are sure you want to delete the selected icon. 

Select Yes to delete the icon, or No to keep the icon on the User Profiles tab.

To display User icons:
1. On the View menu, select how you want User icons displayed on the User Profiles tab. Choose Large

Icons, Small Icons, List format or Detailed list format. The Large Icons option is selected by default. A 
checkmark by an option indicates that it is selected. 

2. Right click on the User Profiles tab. A submenu appears. Select how you want the icons to be 
displayed.

To rename a User icon:
1. Display the User Profiles tab.
2. Select the User icon you want to rename.
3. Select Rename, located on the File menu, or press the right mouse button and select Rename.
4. Type the new name for the User icon in the text field. The new name takes effect immediately.

Notes...
· When you require logins, you must have set up at least one User Profile for anyone to be able to 

connect with you.
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Protecting Your User Profiles
Protect access to your User Profiles by setting security options on the Security dialog box.

To require an access password for your User Profiles:
1. Open the Security dialog box, located on the Options menu.
2. Type a password in the Security Password field.
3. Select User Profiles.
4. Click Apply or OK. You will be asked to confirm your password. Type the password exactly as you did 

the first time, and choose OK.

To change the existing access password for your User Profiles:
1. Open the Security dialog box, located on the Options menu.
2. Enter your new password in the Security Password field.
3. Choose Apply or OK. You will be asked to confirm your password. Type the password exactly as you 

did the first time, and choose OK.

To disable password protection for your User Profiles:
1. Open the Security dialog box, located on the Options menu.
2. Deselect the User Profiles check box.

This allows unprotected access to your User Profiles. 

Notes...
· An access password is NOT required by default. 
· Your access password may include any displayable characters (including spaces), and is NOT case 

sensitive. It is always shown as asterisks. Use an access password you will remember, or you will not 
be able to edit your own User Profiles.



Login Tab
On this tab, enter a login password for the user to be able to access your PC. 
Login passwords are optional. The login password appears as asterisks. You must retype the login 
password in the Confirm Password field for verification. Type the login password exactly as you did the 
first time, and choose OK. If the passwords in the Login Password and Confirm Password fields do not 
match, you will be prompted to enter them again.



Callback Tab
On the Callback tab, select a callback type and set up additional callback information.
When you receive a call from a user that you have set up with a callback type, Carbon Copy hangs up 
and dials the callback phone number. This confirms that the call actually came from the authorized PC. It 
also reverses the telephone charges.
Available callback types are:
None No callback is performed. This is the default.
Fixed The PC placing the call is called back at the number in the Callback Phone Number 

field. You must enter a phone number in the Callback Phone Number field when you 
select Fixed.

Roving Entering a phone number in the Callback Phone Number field is optional. If you enter 
a number in this field, it becomes the default number. When the user who originates 
the call dials in, the default call back number, if supplied, appears in the Roving 
Callback dialog box. The connection can be made using this phone number, or can be 
changed if the user is at a different location.

Passthrough Passthrough works the same as Roving Callback, except you are given the additional 
option of completely bypassing the callback.

Callback Phone Number - Enter the callback phone number in this field.



Profile Tab
On the Profile tab, you can determine which Carbon Copy utilities the user can access once they are 
connected to your PC.
By default, all the utilities are selected, except for the Phone Book, User Profiles, AutoPilot, and the 
Security Options dialog box.



New User Wizard
The New User Wizard allows you to create a customized profile for each user who will be connecting to 
your PC. When you create a User Profile, you set up information for each user, including login name and 
password, callback types and access to Carbon Copy applications.
These options allow you to increase security when another user connects to your PC.



New User Wizard - Login Information
Enter a user name and login password for the user who will be connecting to your PC.
Login passwords are optional. The login password appears as asterisks. You must retype the login 
password in the Confirm Password field for verification. Type the login password exactly as you did the 
first time, and choose OK. If the passwords in the Login Password and Confirm Password fields do not 
match, you will be prompted to enter them again.



New User Wizard - Callback Type
Select a callback type for the user. Available callback types are:
None No callback is performed. This is the default.
Fixed The PC placing the call is called back at the number in the Callback Phone Number 

field. You must enter a phone number in the Callback Phone Number field when you 
select Fixed.

Roving Entering a phone number in the Callback Phone Number field is optional. If you enter 
a number in this field, it becomes the default number. When the user who originates 
the call dials in, the default call back number, if supplied, appears in the Roving 
Callback dialog box. The connection can be made using this phone number, or can be 
changed if the user is at a different location.

Passthrough Passthrough works the same as Roving Callback, except you are given the additional 
option of completely bypassing the callback.

Callback Phone Number - Enter the callback phone number in this field.



New User Wizard - Profile
Select which Carbon Copy utilities the user can access once they are connected to your PC.
By default, all the utilities are selected, except for the Phone Book, User Profiles, AutoPilot, and Security 
Options.
You can also select whether this user is allowed to connect by checking the “Allow Connections” 
checkbox.



New User Wizard - Finish
This is the last screen for the New User Wizard. To make any changes to the information you just entered,
click Back. The New User Wizard screens will reappear. When you are done creating the User Profile, 
click Finish. The entry will be saved, and displayed on your User Profiles tab. 
To make changes to this User Profile later, highlight it and select Properties, located on the File menu.



Using the Remote Clipboard
When PCs are connected using Carbon Copy, they can share a common clipboard. The clipboard shared 
by the connected PCs is referred to as the Remote Clipboard. Using the Remote Clipboard, you can cut 
or copy text and graphics from an application on the remote machine and paste them directly into an 
application on the local machine, or vice versa. 
1. Select Remote Clipboard from the Utilities menu, or click the Clipboard button on the Carbon Copy 

toolbar.
2. Open the application and select the items you want to cut or copy.
3. Select Copy from the Edit menu to copy the items, or Cut from the Edit menu to cut the items.
4. Open the application on the connected PC into which you want to paste the items.
5. Select Paste from inside the application to paste the items.



Starting Utilities upon Connection
You can select or change the Carbon Copy utilities that will automatically start when you make a 
connection.

To select or change the utility to Start upon Connection:
1. Select the Phone Book entry for which you want to setup utilities to start upon connection.
2. Select Properties, located on the File menu.
3. Select the Startup tab.
4. Select Remote Control, File Transfer, Voice Chat, Remote Clipboard, or Remote Printing. Remote 

Control is selected by default.

Notes...
· The Start upon Connection utilities set by the caller takes effect on both PCs when the connection is 

established.



Setting Reboot On Disconnect
Reboot on Disconnect allows your PC to automatically reboot when a connection has ended.

To set reboot on disconnect:
1. Open the Security Options dialog box, located on the Options menu.
2. Display the Connections tab, and select Reboot on Disconnect.

Use Reboot on Disconnect to:
· Prevent other users from calling into a PC after a connection is ended.
· Allow a user to restart an unattended remote PC and reconnect, if an unexpected problem occurs.

To prepare for reconnection with an unattended PC:
Note: Complete the following procedure on the PC to which you will be connecting. 
1. Select PC to Wait for Calls on Startup.
2. Select Load Carbon Copy Before Windows Login Prompt, on the Global tab of the Security Options 

dialog box. 
3. Select Reboot on Disconnect.

Using this setup, if the PC that placed the call disconnects after a crash, the remote PC will reboot, 
start Carbon Copy, and prepare to be called again. Keep in mind that the remote PC may not be able 
to do anything at all after a serious error, so rebooting after a crash is not always possible.
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Exiting Carbon Copy Utilities
To exit File Transfer, or Chat:
Choose Exit, or press ALT+F4.

To exit Remote Control:
Select the Exit icon from the toolbar, or use the selected hot key combination - for example, 
ALT+RIGHTSHIFT. Another way to exit Remote Control is to click the Close button in the upper right 
corner of the Remote Control window.

Notes...
· When either user exits a utility, the utility is closed on the other user's screen as well.
· You must abort a file copy or synchronization if one is in progress before you exit File Transfer. The 

remaining files will not be copied or synchronized, and any incomplete copies will be erased.
· Choosing Exit from the main Carbon Copy window will close Carbon Copy entirely.
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Exiting Carbon Copy
To exit Carbon Copy completely:
1. Choose Exit from the File menu.

Or
Choose the Exit icon from the Carbon Copy toolbar.
Or
Click the Close button in the upper right corner of the Carbon Copy Window.

Notes...
· When you are using Remote Control, and trying to exit Carbon Copy, be sure that you are closing 

Carbon Copy on your PC and not on the PC to which you are connected.
· Closing a Carbon Copy utility such as Remote Control or File Transfer does not close the Carbon 

Copy connection. You need to hang up the call, or close Carbon Copy.

{button ,AL(`exiting',0,`',`')}    Related Topics



Quick Start
Getting Carbon Copy up and running
If you are reading this Help, you have already completed at least this first step...

1)      Run Setup.
Follow the instructions on your screen to install Carbon Copy.

2)      Start Carbon Copy.
The PC you plan to connect with must also be running Carbon Copy and set to Wait for Calls.

3)      On the PC that will be making the call, display the Phone Book tab and create a new Phone
Book entry using the Create New Connection Wizard.

4)      Place the call.
Select the Phone Book entry you created in Step 3, and click the Call button in the main Carbon Copy
window.

5)        Enter your login name and password, if the PC you are calling requires them.
You can require remote callers to give a valid name and password to connect with your PC. If the 
user you are calling has done this, you must provide valid information when you call.

6)      You are there!

Now you can...
Use Remote Control to operate one PC from the other PC’s location.
Use File Transfer to copy and synchronize files and directories on both computers.
Use Chat to converse with the other user.
Use Remote Clipboard to copy and paste information between the local and remote PC.
Use Remote Printing to print a document from one PC to a printer located at a distant PC.
Carbon Copy also lets you...
Use your Phone Book to keep a list of numbers you call frequently. Carbon Copy can dial the number,
and send your name and password automatically.
Setup User Profiles to control access to your PC by remote users.
Use the Options commands to configure Carbon Copy to your needs and work habits.



What Is Remote Computing?
Introduction to the Carbon Copy utilities
Choose underlined topics for more information.

Controlling A Remote PC
Using Remote Control, you can operate another PC as if you were there. Though the PCs are 
connected only by modem, serial or parallel direct connect cable, or via a network connection, you see 
the other PC's screen. Your typing and mouse movements control the other PC as though it were your 
own. You can do work on a computer in another room, city or country.

Copy and Synchronize Files and Directories
Using File Transfer, you can copy and synchronize files between PCs. You can also delete files, and 
create or remove directories on your own or on the connected PC. File Transfer is similar to Windows 
Explorer, extended to operate over the directories of multiple computers.

Remote Clipboard
Remote Clipboard is one clipboard shared by the connected PCs. Using the Remote Clipboard, you 
can copy information between applications on the connected PCs.

Remote Printing
Remote Printing allows you to print a document from one PC to a printer located at a distant PC.

Voice Chatting
Voice Chat allows you to converse with another user.    If both users have a sound card with speakers 
and a microphone, you can talk to each other.    You can also type messages back and forth.

Other Utilities
Carbon Copy provides other utilities to make remote computing easier, more secure, and more 
productive.

Using the Phone Book, you can create a list of Carbon Copy users you call frequently, and Carbon 
Copy can dial them automatically.
By setting up User Profile entries, you can require users to have a valid user name and password 
combination to connect with your PC.



Carbon Copy Sample Applications
Sample applications for Carbon Copy...

· Troubleshoot a problem on another user’s PC as a technical advisor.
· Access applications or files on another PC.
· Work at home and access your office PC.
· Run intensive tasks on a remote machine that is faster or has more memory.
· Edit a document you are collaborating on with workgroup members in another city.
· Demonstrate a problem you are having with an application to a person at another location.
· Allow files or applications on your PC to be used by a connected user in another location.
· Make your office PC available so you can call it from home.
· Make the speed or memory capabilities of your PC available to other users.
· Allow other workgroup members to view and edit a document you are working on together.



Select Administrative or Shared Installation
From this dialog box, select either an Administrative Installation, Shared Installation or Remote 
Installation.
Administrative Installation - Copies all Carbon Copy 32 components to the network drive. The 
completed installation is equivalent to the original Carbon Copy 32 diskettes. The end user can then 
install Carbon Copy 32 to their local drive.
Shared Installation - Installs selected components of Carbon Copy 32 to a network drive. This creates 
an installation that can be shared by multiple Carbon Copy users, allowing the shared files to remain on 
the network.

Remote Installation - Select this option if you want to install Carbon Copy 32 to a remote PC on the network. Once the Remote 
Installation is complete, the remote user will have a complete version of Carbon Copy 32 installed on their PC.



 Select Drive and Directory
From this dialog box, select a computer and share name, and the directory where you want to install 
Carbon Copy 32.
Computer and Share Name - In this field, enter the drive where the remote PC is located, or the name of
the PC to which you want to install Carbon Copy 32. If you do not know the name or location of the PC, 
click the Browse button to locate the PC. 
On a Windows NT PC, you can use $ to indicate the directory. For example, if you enter \\
ComputerName\C$ (where C indicates the drive), Carbon Copy 32 will be installed to the directory in the 
Install Directory field.
You can also enter a mapped drive. When you enter a mapped drive, Carbon Copy 32 will be installed to 
the directory where the drive is mapped.
Install Directory - Select the directory where you want to install Carbon Copy 32 on the remote PC. The 
directory, \Program Files\Carbon Copy 32 is selected by default.
When you are done selecting a computer and installation directory, click OK to continue.
When Carbon Copy 32 installation is complete, the remote PC is rebooted by default, and set to Wait for 
Call on all available protocols. You can connect to the remote PC and complete any remaining setup 
tasks.

If you do not want the remote PC to reboot after Carbon Copy 32 installation, complete the following steps:
1. Open the file SETUPCCW.INI.
2. Locate the line ExitWindowsExec=Yes. Change the line to ExitWindowsExec=No. The remote PC will 

not reboot after Carbon Copy 32 installation is complete.
3. Locate the line WaitForCallOnStartup=On. Change the line to WaitForCallOnStartup=Off. The remote 

PC will not automatically be set to Wait for Call after Carbon Copy 32 installation is complete.
4. Save and close the file.



Select Full or Workstation Installation
From this dialog box, select either a Full Installation or Workstation Installation.

Full Installation - Installs Carbon Copy 32 components you select from the network to your local hard drive. If you are not sure 
of the location of the Carbon Copy 32 installation on your network, contact your System Administrator.

Workstation Installation - Installs Carbon Copy 32 from the network, allowing the shared Carbon Copy 32 files to reside on the 
network. If you are not sure of the location of the Carbon Copy 32 installation on your network, contact your System 
Administrator.



Select Carbon Copy 32 Components to Install
From this dialog box, select the Carbon Copy components you want to install.
Carbon Copy 32 - Installs Carbon Copy 32. 
Carbon Copy Terminal - Use to connect your computer to other computers and information services.



Start Remote System
This feature is used to remotely start Carbon Copy on a Windows NT workstation so that you may 
connect to it.
Enter the name of a workstation on the network that you want to start Carbon Copy.
Carbon Copy on that machine should be set to “Wait for Call” on startup so that you can connect to it.



Locate Old Phone Book or User Profiles
Enter the directory where the old User Profile or Phone Book is located.



File Menu Commands

Create New Connection
Start the New Connection Wizard. Create an icon you can use to connect to another PC.

Create New User
Start the New User Wizard. Setup Security options for users who will be connecting to your PC.

Create New AutoPilot
Start the AutoPilot Wizard. Create an Automated File Transfer icon.

Create Shortcut
Create a shortcut icon that appears on your desktop.

Delete
Delete the selected User or Connection.

Rename
Rename the selected User or Connection.

Properties
View the Properties for the selected User or Connection.

Event Log
Start, view, or stop an Event Log.

Exit
Exits Carbon Copy
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Connections Menu Commands

Place a Call
Place a call to a Carbon Copy PC already set to wait for calls. 

Wait for Call
Set your PC to receive an incoming call.

Hang Up
Disconnects your computer from a PC connected to it.

Browse Network
Browse the network for Carbon Copy PCs set to Wait for Call. Select Stop Browsing Network to stop 
browsing the network.

Start Remote System
Starts Carbon Copy as a service on a remote Windows NT workstation.
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Utilities Menu Commands
These commands start Carbon Copy's utilities.    You must have a Carbon Copy connection to start any of
these utilities.

Remote Control
Operates a remote PC, using your own keyboard and mouse.

File Transfer
Exchanges or deletes files between connected PCs, and creates or removes directories.

Voice Chat
Lets you converse with another user with speakers and microphone, or by typing text.

Remote Printing
Allows a document printed from one PC to be routed to a printer located at a second PC.

Remote Clipboard
Allows connected PCs to share a clipboard for copying and pasting functions.
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Options Menu Commands
These commands configure Carbon Copy to your work style and needs.

Communications
Selects the way in which Carbon Copy will make a connection between PCs.

Security
Set security options for Carbon Copy.

Remote Control
Sets Remote Control options.

File Transfer
Sets File Transfer options.

Voice Chat
Sets Voice Chat options.

Remote Printing
Sets Remote Printing options.

Minimize on Use
Toggles on and off to minimize the main Carbon Copy window when you start other Carbon Copy utilities.

Display Status
Toggle the Status tab on or off.

Display AutoPilot
Toggle the AutoPilot tab on or off.
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File Menu Commands - File Transfer
These commands manipulate files and directories between the connected PCs.

Copy
Copies selected files and directories from one PC to a connected PC.

Synchronize
Synchronizes files and directories on the connected PCs so that they contain the same information.

Delete
Deletes selected files and directories from your PC or the connected PC.

Rename
Rename the selected file or directory.

Properties
Check the properties of the selected file or directory.

New Folder
Create a new file folder.

Exit
Exits File Transfer.
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Edit Menu Commands - File Transfer

Cut
Cut the selected file or directory to the Windows clipboard.

Copy
Copy the selected file or directory to the Windows clipboard.

Paste
Paste a file or directory in the active window.

Select All
Select all files in the current directory.

Invert Selection
Deselect the currently selected files. Selects previously unselected files in the directory.



View Menu Commands - File Transfer

Toolbar
Toggle the File Transfer Toolbar on and off. A checkmark by the Toolbar option indicates that is it on.

Status Bar
Toggle the File Transfer Status Bar on and off. A checkmark by the Status Bar option indicates that is it on. The Status Bar 
contains information about the currently selected items.

Side by Side
Displays the File Transfer windows next to each other.

Large Icons
Displays files using large icons. This option is selected by default.

Small Icons
Displays files using small icons.

List
Displays files in list format.

Details
Displays files in detailed list format. Details include file name, size, type, last modification date and file attributes.

Arrange Icons
Use the options on the Arrange Items submenu to sort and display files by name, type, size or date.

Refresh
Redraws the File Transfer windows. This may be useful after transferring files or creating new files.

Options
Displays the Options dialog box. On this dialog box, you can set Transfer, Include, Confirmation and 
Directory Restrictions options.



File Menu Commands - Chat

Exit
Exits Chat.
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Edit Menu Commands - Chat

Copy
Copies the entire contents of the Chat windows into the Windows Clipboard. You can later paste this text into an application.

Paste
Pastes the entire contents of the Windows Clipboard into the Chat window.

Clear Windows
Clears the Chat windows on your PC.
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Terms



Accelerator key
A key combination that executes a command.



Access password
The passwords you can require users to provide in order to open your Phone Book, User Profiles or 
Security Options dialog box. You set the access password on the Security Options dialog box.



ACS
Asynchronous Communications Server.



Administrative Installation
Install Carbon Copy on a network drive. Allows user to install selected Carbon Copy components (Carbon
Copy and Carbon Copy Terminal) locally.



Application
A program a user runs on their computer.



Auto-Answer
A modem feature which enables the modem to answer calls automatically.



Baud
A single change in electrical signal. One baud can actually produce one, two, or even four bits of data.



Bits per second (bps)
The speed of data communication in bits per second.



Callback
A feature used to verify a caller, or to reverse telephone charges. When callback is selected, and a user 
calls you, Carbon Copy automatically hangs up, and calls back at the callback phone number.



Carbon Copy Connection
Create a Carbon Copy connection when you will be connecting to another PC via direct connect, IPX, 
TCP/IP or modem.



Carbon Copy Gateway Server
Carbon Copy application you use to make a modem attached to a network workstation (the Carbon Copy 
Gateway Server) available to any user on the network.



Carbon Copy Terminal
The Carbon Copy utility that allows you to connect your computer to other computers and information 
services. You can store the phone numbers of remote computers in the Carbon Copy Terminal Phone 
Book.



Carbon Copy Terminal Script Language
Use to create a set of instructions, ranging from very simple to extremely complex, for Carbon Copy 
Terminal to follow. This script language can only be used with Carbon Copy Terminal.



CD
Carrier Detect.    An RS232 signal which notifies the PC that the modem has detected a carrier signal over
the communications line.



Chat
The Carbon Copy utility that allows you to "converse" with the other user onscreen.



Chat windows
The windows that hold text typed during Chat. Each PC stores and displays both PC’s Chat text.



Choose
To make a command take effect, usually with a menu or screen button.



COM port
The PC connector where you attach a modem or null modem cable. A serial printer or mouse may also 
attach to a COM port.



Connection
The state where a PC is connected to another PC via a modem, direct connection, or network.



Connection Security
Protection against unauthorized access to your PC, by requiring all callers to provide a valid login name in
order to connect. For additional security, you can also require a login password and callback phone 
number.



CTS
Clear to Send. An RS232 signal which tells the local PC    to send data to the modem.



DCD
Data Carrier Detect.    An RS232 signal sent from the modem to the local PC, indicating that the modem is
ready to establish a connection.



Dial-up Networking Connection
Create a Dial-up Networking connection if you will be establishing a remote network node.



Dial modifiers
Command characters inserted in a phone number that make the modem dial in a special way.



Dimmed
Grayed-out, unavailable. Commands in a menu that cannot be used are dimmed.



Direct connection
A connection between two PCs that are hard-wired together with a null modem cable or serial port cable. 
Modems are not used in a direct connection. 



DOS Host
The Carbon Copy for Windows TSR that allows a PC to remotely control a Windows full-screen DOS 
application outside of Windows.



DTR
Data Terminal Ready. An RS232 signal which tells the modem that the local PC is ready to begin 
communications.



Event Log
The Carbon Copy feature which allows you to keep a log of different message types received by Carbon 
Copy.



Start upon Connection
Allows you to select the utilities that Carbon Copy starts automatically when a connection is made. You 
can select Remote Control, File Transfer, Chat or Remote Clipboard. 



File Transfer
The Carbon Copy utility that allows users to exchange, delete and synchronize files and directories.



Interactive Dial
Use this Carbon Copy feature to connect to a PC that is not directly connected to a modem or network.



Local
Your PC, as opposed to the PC to which you are connected.



Login name
The name a caller must provide when connecting with a PC that requires logins.



Login password
The password a caller must provide when connecting with a PC that requires logins. Login passwords are
optional and separate for each login name.



Maximize
Enlarge a window or icon to its largest possible size.



Minimize
Shrink a window to an icon.



MNP-10
Microcom Networking Protocol Class 10. An advanced communications protocol which performs both 
error correction and data compression. When both modems in a connection are using MNP-10, they may 
be able to connect at a higher speed than without MNP-10.



Modem
A device that transmits computer data over telephone lines to another computer. A modem can be internal
to the computer, or can be an external unit that connects to the PC with an RS232 cable.



NASI
(NetWare Asynchronous Services Interface) An ACS interface that manages data flow between a 
workstation on a network and an ACS.



NCSI
(Network Communications Services Interface) An ACS interface that manages data flow between a 
workstation on a network and an ACS.



Null modem cable
A specially wired cable that allows PCs to be wired together directly, instead of using modems to connect 
over telephone lines.



Phone Book
Contains a list of names and phone numbers used to dial another PC. It also contains login names and 
passwords that you may need to provide in order to connect to the other PC.



Port
A communications connector that allows sending and receiving of data over a connected cable.



Reboot
Restart your PC.



Remote
The PC or user, usually at another location, to which you are connected.



Remote Control
The Carbon Copy utility that allows a user to control a connected PC. Whichever user launches Remote 
Control controls the others PC. You can choose to display the Remote Control window full-screen, or in a 
smaller, resizable window on your desktop.



Remote Clipboard
The Carbon Copy utility that allows connected PC’s to share a common clipboard. You can cut and copy 
text and graphics from an application on one PC and paste it directly into an application on the other PC.



Remote Drive Access
The Carbon Copy utility that allows you to share selected drives and directories. After setting up drives 
and directories for sharing, you can use Carbon Copy drive mapping options to map drive letters to 
shared directories on the other PC.



Remote Printing
The Carbon Copy utility that allows you to send a print job from the Host PC to the Guest printer. You can 
send a print job to the printer attached to the Host PC, Guest PC or both.



Restore
Return a minimized window to its previous size.



RS232 cable
A standard interface cable used to connect data communications equipment to a PC.



RTS
Ready to Send. An RS232 signal the local PC sends to the modem to indicate readiness to transmit data 
to the modem.



Select
To highlight an item. Selecting doesn't make anything happen, it determines the "target" of a command 
issued separately.



Serial Port
A connection on a device for serial communications.



Shortcut key
A key combination that executes a command.



Terminal Emulator
The Carbon Copy utility that allows you to connect your computers to other computers and information 
services.



TAPI (Telephony API)
A standard for communicating with equipment such as modems.



UART
Universal Asynchronous Receiver-Transmitter. A computer chip that controls the serial port.



Uninstall
The Uninstall utility is installed when you install Carbon Copy. Use Uninstall to remove Carbon Copy from 
your PC.



Utility
Any of the following applications within Carbon Copy:
Remote Control, File Transfer, Chat, Phone Book, Remote Clipboard, Uninstall or User Profiles.



Wait for Call
The state where Carbon Copy is prepared to answer a call from another PC.




